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Disclaimer 
 

Information in this document is subject to change without notice and does not represent a 
commitment on the part of VeEX Inc. The software and/or hardware described in this 
document are furnished under a license agreement or nondisclosure agreement. The software 
may be used or copied only in accordance with the terms of the agreement. It is against 
the law to copy the software on any medium except as specifically allowed in the license or 
nondisclosure agreement. The purchaser may make one copy of the software for backup 
purposes. No part of this manual and/or hardware may be reproduced or transmitted in any 
form or by any means, electronic or mechanical, including photocopying, recording, or 
information storage and retrieval system, for any purpose other than the purchaser’s personal 
use, without the express written permission of VeEX Inc. 

 

Throughout this book, trademarked names are used in an editorial manner only and to the 
benefit of the trademark owner, with no intention of infringement of the trademark. Where such 
designations appear in this book, they have been printed with initial capital letters. 

 

Microsoft Windows is a registered trademark of Microsoft Corporation. 

CLEARPath™ is a registered trademark of Electroline Equipment. 
 

All other trademarks, copyrights, logos, brand names, etc. mentioned herein are the property of 
their respective owners. 
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About this manual 
 

This manual describes the VeEX WinCom and ReVeal WinCOM data management 
software that helps you take full advantage of information collected with your VeEX 
analyzer. WinCom and ReVeal WinCOM are packaged in the same software and many 
of the commands are common to both programs, especially for the AT2000 series. Unless 
otherwise stated, instructions are the same for both programs. Wherever required, this 
manual specifies whether the command is only for WinCom or only for ReVeal 
WinCOM. Please note that only ReVeal WinCOM supports the AT2500 series analyzer. 

 

Before using any WinCom or ReVeal WinCOM software, you should already have a 
working knowledge of your model of the VeEX spectrum analyzer and you should know 
how to save measurement data and site information. If you are unfamiliar with these 
functions, consult your VeEX analyzer operation manual. 

 

Scope 
 
 
 
 
 

Abbreviations 

 
 
This manual assumes the user has a basic knowledge of computers, the Windows 
operating system and the VeEX spectrum analyzer, including the QAM analyzer features 
where applicable. 
 
 
 

ASCII           American Standard Code for Information Interchange 
AUTO           Auto Test 

BAS Bidirectional Alignment Trace 
CW   Carrier Wave or Continuous Wave 

DHCP   Dynamic Host Configuration Protocol 
DIST  Distortion Trace 

DM  Depth of Modulation Record 
DNS Domain Name Server 

DPWR           Digital Power Record 
FCC  Federal Communications Commission 

FR  Frequency Response Record 
HUM           Hum Modulation Trace 

MPEG           Motion Pictures Expert Group 
POP  Proof of Performance 
PPM           Parts Per Million 

QAM           Quadrature Amplitude Modulation; also a QAM Mode Record 
SA Spectrum Analyzer Mode Trace 

SLM1           Signal Level Meter Bar Graph (Frequency Counter) 
SLM2           Signal Level Meter Bar Graph (TV Channel Mode) 
SLM6           Signal Level Meter Bar Graph (6 channels) 
SRTB           Sunr i se  (VeEX) Telecom Broadband 

TCP/IP  Transmission Communication Protocol / Internet Protocol 
TDM           Time Domain Measurement Trace 
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Terms 
 

 
Autocal  Routine that automatically adjusts the spectrum analyzer’s 

measurement functions to a set of computer-generated traceable 
calibration standards, compensated for the current ambient 
temperature. 

Autotest     Function to automatically measure frequencies and levels for all 
tagged channels and frequencies in the active channel plan. 

Baud Rate    Rate at which the data is sent over serial communications, measured 
in bits per seconds (bps) or in baud (state changes per second). Baud 
and bps are synonymous only for two-level modulation with no 
framing or stop bits. 

Channel Plan  List of channels (line-up) for a particular headend or location. 
Channel Plan 

File 
List of channel plans within a selected file. A channel plan contains 
individual channel line-ups. 

Domain  A name that identifies one or more IP addresses. 
Gateway    Alternate term for router. Computer network device that connects 

autonomous systems by intercepting and routing data from one 
network to another. Gateways use the subnet number of data and 
determine which IP addresses to process based on a subnet mask. 

Hub  Computer network device that accepts data from multiple points and 
then forwards the data using a switch. 

Records 
Database 

File named Records.bin, used for uploading traces and their settings 
to the AT2000 spectrum analyzer. The number of traces that can be 
stored in a Records Database file is limited to 100 trace records for 
the AT2000 series analyzer. 

Reference Level  Measurement level in dBmV shown at the top of the graticule 
display. The reference level is user-definable with a given range. 

Remote 
Spectrum Mode 

Mode of operation where the spectrum analyzer is controlled by a 
VeEX software application running on a PC. 

Router  Device that forwards packets between networks. The decision to 
forward or not is based on the network layer and routing tables. 

Subnet     A segment of an IP network. In an IP address, a portion of the 
address is used to identify the subnet. A subnet mask is used by 
routers to forward data to the network segment, based on its own 
routing tables. A typical subnet mask is 255.255.255.0, which 
indicates that the router should allow or deny access based on the 
first three parts of the IP address. 

Tag  In WinCom, a checkmark indicating that a record has been selected 
for printing. 

Test Point  Connection on a device used for making signal measurements. 
WinCom 
Database 

File named *.WCD, used for archiving traces from AT2000 series 
analyzers on a computer There is no trace count limitation (see also 
Records Database). The WinCom database file can store traces from 
multiple AT2000 series analyzers. WinCom database records can be 
converted to a records database file and uploaded to an AT2000, 
providing trace-count limitations of the AT2000 are observed. 
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Chapter 1 PRODUCT OVERVIEW 
 
 

1.1 Welcome 
 

The ReVeal WinCOM software package is a data management software that is used with the 
VeEX AT2000 and AT2500 series spectrum analyzer products, providing access to the 
information collected with the analyzer, enabling firmware upgrades, and allowing you to 
download files to the analyzer or store files on your PC. 

 

The ReVeal WinCOM software package communicates with the AT2500 series analyzers and 
also incorporates a version of WinCom for the AT2000 series. 

 

The WinCom application offers a built-in charting utility, TraceView. TraceView utilizes your 
PC to display the data collected with the analyzer so you can analyze, chart, and print various 
reports to help effectively manage your cable system. This utility displays record traces and 
exports measurement data directly to the Windows clipboard, in BMP format, to a VeEX or 
FamilyWare proof of performance file (.CSV and .TSD), or an ASCII text file (.CSV) for 
processing in a spreadsheet program. 

 

The ReVeal WinCOM software package also provides an easy way of upgrading the 
AT2000 and 
AT2500 analyzers with the latest firmware, without having to return the unit to the factory. 

 
Note:  Some upgrades  require hardware changes as well as new firmware.  In these situations, 

the unit must be returned to the factory. 
 
 
 

1.2 Package Contents 
 

Please verify that your software package is complete. It should contain the following items: 
• ReVeal WinCOM software package on CD 
• ReVeal WinCOM User’s Manual (Hard copy and integrated help file) 
• Null Modem cable (for direct PC-to-analyzer serial connection) 
• Ethernet Crossover Cable (for direct PC-to-analyzer Ethernet connection) 

 
 
 
 

1.3 Technical  Assistance 
 

VeEX maintains regular office hours from 8:00 AM to 8:00 PM Eastern time, Monday 
through Friday. Call Customer Care at the number below, or e-mail us for technical and sales 
support. Please see Chapter 7 for licensing details. 

 

Tel: +1 510 651 0500 
Fax: +1 510 651 0505 

E-mail: customercare@veexinc.com
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1.4 Online Help 
 

The Help menu provides you assistance with this application. Use this menu to access the 
product version number, which you may need for technical support purposes. 

 

You can register the ReVeal WinCOM software through the Help menu. If you have 
received a password for your product (see section 2.4 on page 2-5), you can use this menu to 
access the dialog box for registration. Once you are registered, there is no time limit to 
usage of ReVeal WinCOM. 

 

In addition to these basic Help functions, WinCom includes on-line help available when you 
select Help Topics from the Help menu, a link to the release notes that may be shipped with the 
product (ReadMe.txt file), and a link to the VeEX website. 
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Chapter 2 INSTALLATION AND SETUP 
 
 
 

2.1 Preparing  to Install ReVeal WinCOM 
 

Before you install ReVeal WinCOM, make sure your computer meets the minimum 
requirements. To save time connecting your spectrum analyzer to your computer, make sure 
you have the right cables. Cables for direct connections are provided. 

 
2.1.1 System Requirements 

 
The following table shows the recommended minimum platform requirements for ReVeal 
WinCOM. 

 
Table 2-1: ReVeal WinCOM Requirements 

 
Category  Minimum  Requirements 

 
Machine Class  Pentium, 1GHz or better 
Main Memory  256 MB of RAM 
Display/Video card  SVGA, 800 x 600 resolution 
CD-ROM  Any type 
Hard Disk Size 500 MB 
LAN  Ethernet 10/100 
Operating System  Windows 2000 or Windows XP 

 
 

2.1.2 Connection Requirements 
 

You need to connect your PC to a VeEX spectrum analyzer in order to transfer files or 
upgrade firmware. Three standard connection types are supported: 

 
Table 2-2: Connection Types and Cabling Requirements 

 
Connection Type  Required Cable 

 
 

1. 
 

Networked Ethernet communications (using a hub) 
 

Standard Ethernet cable 
2. Direct (PC to analyzer) Ethernet communications Crossover Ethernet cable 
3. Direct (PC to analyzer) serial communications Null modem cable 
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2.2 Connecting to an Analyzer 
 

The AT2000 and AT2500 analyzers support a direct RS-232 connection, a direct Ethernet 
10Base-T connection or an Ethernet connection to a local area network (LAN). Null modem 
cables for direct connections are provided with ReVeal WinCOM. For a LAN 
connection, use standard Ethernet cables. These cables are not provided. 

 

On the analyzer, you need to set up the remote connection. Refer to the analyzer’s user guide 
for complete instructions on setting up TCP/IP or serial communications. Check the following: 

• Make sure that you set the system type to Server. 
• Make a note of the system ID since ReVeal WinCOM requires this information to 

complete the connection setup. 
• Make sure the analyzer is in remote mode. 

 
The following sections cover the three possible connections, as shown in Figure 2-1: 
1.    an Ethernet connection to a local area network (LAN) 
2.    a direct Ethernet 10Base-T connection 
3.    a direct RS-232 connection 

 

 
Figure 2-1: Connecting to an Analyzer 
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2.2.1 Cabling a Network Connection 
 

To communicate over a LAN, the analyzer and your PC running ReVeal WinCOM must be 
connected to the same network via a hub or router. Do not use crossover cables for these 
connections; use standard Ethernet cables. These cables are not provided. 

Refer to Figure 2-1. These instructions are for the cabling numbered “1” in the diagram. 

To set up a network connection: 
1.    Connect your PC to your network using a straight-through standard CAT-5 Ethernet cable. 
2. Connect the analyzer to your network using a straight-through standard CAT-5 Ethernet 

cable. Use the RJ-45 jack on the analyzer. On “R” models, the RJ-45 jack is on the front of 
the unit. On “HM” models, the RJ-45 jack is on the rear of the unit. 

 
2.2.2 Cabling a Direct Ethernet Connection 

Refer to Figure 2-1. These instructions are for the cabling numbered “2” in the diagram. 

To set up a direct Ethernet connection: 
Connect your PC directly to the analyzer using a crossover Ethernet cable. This cable is 
provided with ReVeal WinCOM. Use the RJ-45 jack on the analyzer. On “R” models, the RJ-
45 jack is on the front of the unit. On “HM” models, the RJ-45 jack is on the rear of the unit. 

 
2.2.3 Cabling a Direct Serial Connection 

 
Refer to Figure 2-1. These instructions are for the cabling numbered “3” in the diagram. 

 

1. Connect your PC directly to the analyzer using a null modem serial cable. This cable is 
provided with ReVeal WinCOM. Use one of the COM ports (DB-9 connectors) on the 
analyzer. On “R” models, the COM ports are on the front of the unit. On “HM” models, 
the COM ports are on the rear of the unit. 

 

2. On the analyzer, set up the serial parameters for the remote connection. Refer to the 
analyzer’s user guide for complete instructions on setting up serial communications. Make 
sure that the communication parameters (baud rate, data bits, parity, etc.) match the 
settings on the analyzer before attempting communications. On the AT2500, please note 
that the maximum baud rate for serial communication is 115,200 baud. 
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2.3  Installing the ReVeal WinCOM Software Package 
 

You may receive ReVeal WinCOM on a CD or from a Web download. The program’s content 
    same for all media. To install ReVeal WinCOM, you need to run the SETUP.EXE program. 

Access 
t  thi   i  di  t  th  di   Note: To downgrade WinCom  II to  an older  version,  the  newer  version  must  be manually 
uninstalled before  installing the older  version.  Do not  install  multiple versions of the 
software on the same computer since this impedes operation of all versions. 

   

Table 2-3: Installation Media 
 

Media  Access to Setup Program 
 

CD  With the ReVeal WinCOM CD, the installation program starts 
automatically when the CD is inserted into the drive. If the program 
fails to start, browse to the root directory of the CD and click 
SETUP.EXE. Follow the onscreen prompts. 

CD Suite                    ReVeal WinCOM may come on a CD containing other VeEX 
Telecom software. Upon insertion of the CD, an installation program 
should automatically execute, allowing you to choose which of the 
applications to install. If the program fails to start, browse to the 
WinCom directory on the CD and click SETUP.EXE. Follow the 
onscreen prompts. 

Web Download – 
ZIP File 

 

 
 
 
 
 
 

Web Download - 
EXE File 

Save the WINCOM.ZIP file from the VeEX Telecom website in a 
temporary directory on your computer, and then extract all of the files to 
a temporary directory, using PKUNZIP or WINZIP. Now, run the 
SETUP.EXE program, in the temporary directory, and follow the 
onscreen prompts. 
Once, installed, the temporary files can be deleted. Keep the ZIP file in 
case you need to re-install the software. 
Save the WINCOM-INST.EXE file from the VeEX Telecom website 
in a temporary directory on your computer and double-click on it to 
perform the installation. This is self-extracting archive decompresses, 
installs and deletes temporary files automatically. Follow the onscreen 
prompts. 

 

 
 
 
 

Once ReVeal WinCOM is installed, contact VeEX Sales Support to get a password to 
activate the software. 
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2.4 Registration 

 

Every time you start an unregistered copy of ReVeal WinCOM, the registration dialog box 
appears. When trying to launch ReVeal WinCOM, the new dialog that appears will contain a 
Program ID. A license key is required to activate a 30-day or a fully licensed copy of the s/w. 
For the 30-day, once the time limit expires, the program will not function until registered. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-2: Registering ReVeal 
WinCOM 

 
To obtain your License Key, contact VeEX Inc. Customer Care. 
 

Customer Care: 
Phone: + 1 510 651 0500 

E-mail: customercare@veexinc.com 
Website: www.veexinc.com 

 
You must provide the following: 

• Program ID 
 

A Customer Service representative will provide you with a password that can only be used on 
the registered computer. Once registered, you proceed directly into the program when you start 
up ReVeal WinCOM. 
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2.5 Setting up ReVeal WinCOM 

 

ReVeal WinCOM can store multiple connection settings for the AT2000 or AT2500 series 
analyzer. When you create a connection setup, you must specify which type of analyzer you 
are using. Once connected, ReVeal WinCOM displays only the functions that are available 
on the analyzer model you have specified. For example, with an AT2500, ReVeal WinCOM 
displays menu options that only apply to a 1.5 GHz device. These options do not appear for the 
1 GHz AT2000. 

 
2.5.1 Setting up Communications 

 

Creating a New Connection 
To create a connection between your computer and the analyzer, go to ReVeal WinCOM’s 
Options menu and select Communication Settings. The device access configuration window 
appears. 

 

The first time you call up this window, the fields are grayed out because there are no 
connections in the list. On the left side of the device access configuration window, click the “+” 
symbol to add a new device. You can now set up the connection to this device. 

 

 
 

Figure 2-3: Setting Up Communications 
 

1. In the Remote Device field, choose a name for the device. You can enter up to 16 
characters, including spaces. This name must be unique. It appears in the list of possible 
devices when you choose Logon using from the Communication menu. 

 

2. In the Device Type field, select AT2000R, AT2000HM, AT2500R or HM. Make sure that 
you identify your device correctly. ReVeal WinCOM uses this field to present 
appropriate menu choices for your device during initial handshaking. 

 

3. In the Connection field, choose either “TCP/IP Network connection” or “Serial connection 
via COMn”, indicating your PC’s COM port (1 to 4). If you are using a modem, you 
must configure it in Windows and not in ReVeal WinCOM. For direct serial connections, 
a null modem cable is required. For a direct TCI/IP connection, a crossover Ethernet 
cable is required. 

 

Depending on whether you are using a serial or Ethernet connection, ReVeal WinCOM 
displays the appropriate fields so that you can specify the communication parameters. 
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Table 2-4: Ethernet and Serial Connection Setup 

 
Connection  Field  Description 

 
•  TCP/IP      Address         Enter the IP address assigned to the analyzer you are connecting 

to. You need to find out what address has been assigned to the 
analyzer before you can communicate with it. If the analyzer is 
connected to a LAN, it may be set up to receive its IP address 
from a DCHP server. If it is set up to use a static IP address, it 
may still be set to the factory default, which is 192.0.1.200.You 
can change the static IP address of the analyzer if desired. Refer 
to the analyzer user’s manual for instructions. 

 
Port Enter the port used for TCP/IP communication with the analyzer. 

It is possible to use a common IP address for multiple devices in 
one site and assign each of the units a different port number. You 
should generally use port numbers above 3000. The default port 
is 3001. 

 
Note:      Avoid   assigning port  numbers   that  conflict with 

standard ports (such as port 21 reserved for FTP) or 
ports in use by other programs or equipment. 

 

•  Serial Baudrate Select the port’s speed (baud rate) for serial communications. 
The analyzer’s default baud rate on COM 1 is 115200. Possible 
values range from 2400 to 115200. Choose a slower baud rate if 
the RS-232 cable connecting the PC to the analyzer is long. The 
speed on your PC’s port and on the analyzer must match. 

 
 

4. In the Local ID field, enter a number for your PC. It must be unique from all other local 
IDs in the system. The default is 10 and ID numbers may range from 10 to 98. 

 

5. In the Remote ID field, enter the system ID assigned to the analyzer. By default, the 
spectrum analyzer’s system ID is set to 1. When you have multiple devices on the same 
serial connection, the ID must be unique. For TCP/IP communications, the remote ID does 
not need to be unique since the IP address is used to route data to the correct unit. 

 

6. In the Retry Count field, select the number of times (from 3 to 6) you want ReVeal 
WinCOM to attempt to connect to an analyzer before responding with a timeout message. 

7. In the Retry Delay (sec.) field, enter the number of seconds (from 1 to 10) that ReVeal 
WinCOM 

should wait before attempting to connect again to the analyzer. 
 

8. Click OK to save the setup. 
 

Editing a Connection 
 

To make changes to an existing connection between your computer and the analyzer: 
 

1. In  ReVeal WinCOM’s  Options  menu,  select  Communication  Settings.  The  device  
access configuration window appears. 

2. On the left side of the device access configuration window, select one of the devices from 
the list. Its name now appears in the Remote Device field. Keep this name unless you need 
to rename the connection. 

 

3. Make any changes to the connection parameters. See steps 2 to 8 in the Creating a New 
Connection section. Remember to click Apply or OK to save your changes. 
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2.5.2 Checking  the Spectrum  Analyzer Setup 

 
Once the device connection has been defined, you need to make sure that the spectrum analyzer 
is set up and connected to the PC or the network, and that the correct ports and cable are used. 
Before attempting to log on, please check the following: 

 

1.    You have connected the proper cabling (see section 2.1.2 on page 2-1). 
 

2. The AT2000 has firmware version 4.21 or higher; and the AT2500 has firmware 1.00 or 
higher. 

 

3.    You have configured the analyzer’s settings. Make sure: 
• You are using the appropriate port and setup 
• The unit is in server mode (system type is set to “Server”) 
• The system ID is correct 
• The analyzer is in remote mode. On the “R” series, from any mode except Menu, 

press the COMM function button to put the unit into remote mode. Or, select the 
Remote icon in the menu, and then select a mode such as Spectrum Analyzer. On 
“HM” models, the unit is normally set to operate in remote mode by default. 

 
4. You have configured the communications in ReVeal WinCOM to match the 

communication settings in the analyzer. 
 

Note:             If your  current  session  crashed  while  connected to the analyzer,  it may take up to 3 
minutes  before Windows will close the socket and before the analyzer will allow another 
log on attempt. 

 
 

2.6 Logging on to a Spectrum  Analyzer 
 

2.6.1 Logging On 
 

The Communication menu in ReVeal WinCOM includes two options for logging on to a 
spectrum analyzer: Logon and Logon Using. Logon attempts to establish a communication 
link with the analyzer, using the last connection that was selected. Logon Using allows you to 
select a connection from a list. Depending on the type of connection, it may take some time to 
establish the connection. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-4: Choosing a Logon Setup 
 

To start a session with a spectrum analyzer: 
 

1. From the Communication menu, select either Logon or Logon Using. Make sure you 
choose a device that is connected to the PC or to the network. 

 

2. If you were able to start the session successfully, the Remote Files pane on the right side of 
the window should now list the files in the remote spectrum analyzer. 
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3. To end your session, select Log Off from the Communication menu. This terminates the 

communication link to the analyzer, freeing it for use by others and allowing ReVeal 
WinCOM to connect to another analyzer. 

 

 
 

2.6.2 Choosing the Date Format 
 

You can choose the date and time format that you want WinCom to use. This function is only 
available in WinCom. 

 

To select a date format: 
 

1. In the ReVeal WinCOM Tools menu, select Launch WinCom. This opens a separate 
window for 

WinCom. 
 

2. In the Options menu, select Date Format. A window appears for selecting international or 
U.S. standard formats. 

 

3. From the drop down list, select the format you want to use. To help you choose, an 
example of the selected format appears at the bottom of the window. 

 

4. Click OK to confirm your choice. WinCom updates the date display on any traces that you 
are viewing (see Chapter 4, Trace Viewer). 

 

 
 

Figure 2-5: Setting the Date Format 



 

 



 

 

 
 
 

Chapter 3 FILE AND RECORD 
MANAGEMENT 

3-1 

 
Each VeEX AT2000 or AT2500 series analyzer can store measurements, traces and 
instrument settings in non-volatile memory. ReVeal WinCOM is used to transfer data 
between your computer and a VeEX analyzer, as well as manage the various files on your 
computer and on your analyzer. 

 

When you first start ReVeal WinCOM, there are no files stored on your computer. To begin 
storing traces and settings on your computer, you must first establish a connection with a 
spectrum analyzer. Then, you can retrieve files from the remote analyzer. To upload files from 
your computer to a remote analyzer, you must first create the file (such as a channel plan) or 
download the file from another analyzer. 

 

This chapter explains how to: 
• select records and files 
• copy records and files to the analyzer 
• retrieve records and files from the analyzer 
• save records and files and delete unwanted records 
• view record properties 

 
 
 
 
 
 

Note:  For information on exporting records  and instrument settings for proof-of-performance 
or FCC testing and compliance documentation, refer to section 4.6 on page 4-19. 
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3.1 Naming Files and Records 

 

WinCom supports two types of databases: the Records Database (Records.bin) and the 
WinCom Database File (*.WCD). Only the records database is uploaded to a remote analyzer. 
The number of traces that can be stored in a records database file is limited to 100 trace records 
for the AT2000 model. The WinCom database does not have a record count limit but is limited 
to the amount of free disk space you have. Always leave enough free disk space for Windows 
to operate properly. 

 

ReVeal WinCOM operates differently because the AT2500 series has a different file 
structure. It stores traces and settings as individual files, rather than as a database. The 
AT2500 can store 
100 instrument settings and 250 trace records. 

 

Each AT2000 and AT2500 file that you can retrieve or upload appears in the following table. 
Upon retrieval, AT2500 files retain the same name and file extension as the one that was used 
on the analyzer. For the AT2000, however, the files are renamed with the file extension 
indicated below. You can choose the first part of the file name. 

 
Table 3-1: Files Stored in Analyzers 

 
AT2000 Files                    AT2500 Files                         Content 

 
Records.bin 
(saved as *.bin on PC) 
Settings.bin 
(saved as *.set on PC) 

 
*.xml in Records directory Stored measurement records and 

traces. 
 
*.xml in Settings directory Stored instrument setups. 

Plans.bin 
(saved as *.pln on PC) 
Colors.bin 
(saved as *.clr on PC) 

 
 
 

Param.bin 
(saved as *.par on PC) 

*.acp in Channel Plans 
directory 
 
Colors.clr in Color Settings 
directory 
You cannot change this 
name on the PC. 
Params.prm in Parameter 
File directory 
You cannot change this 
name on the PC. 

Channel plans for NTSC, PAL or 
other television standards. 
 
Customized color settings used on 
the analyzer. 
 
 
 
User preferences for the analyzer. 
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3.2 Selecting  a Record (AT2500 series) 
 

This section applies to the AT2500 series analyzer and the ReVeal WinCOM user 
interface. See section 3.4 on page 3-5 if you are using an AT2000 series analyzer. 

 

Instead of storing all records in one database file, the AT2500 stores each individual records in 
a specific directory (see Table 3-1 on page 3-2). However, ReVeal WinCOM stores the 
individual records in any directory you want. You may want to organize your records by type. 

 

To select a record in ReVeal 
WinCOM: 

 

1.    Browse to the desired directory. By default, ReVeal WinCOM calls up the list of files 
in the 

\VeEX Telecom directory. If required, browse to another directory. To do so, go to the 
File menu and choose Select folder, or use the drop down directory list in the Local Files 
pane to select a folder. 

 

2. Once you are in the correct folder, click on a record to copy it to a remote AT2500 if you 
are already logged on. See section 3.5 for instructions on copying files. 

 
3.3 Copying  AT2500 Records with ReVeal WinCOM 

 

Use ReVeal WinCOM’s main interface to retrieve individual records or a set of records. In 
order to retrieve records from the AT2500, you must establish a communication connection 
with the AT2500. Note that in order to use ReVeal WinCOM, the AT2500 must be put in 
remote mode. On the “R” series, from any mode except Menu, press the COMM function 
button to put the unit into remote mode. Or, select the REMOTE icon in the menu, and then 
select a mode such as Spectrum Analyzer. On “HM” models, the unit is normally set to 
operate in remote mode by default. 

 

When you log on to an AT2500 series analyzer, you may see only the files on the right, in the 
Remote Files pane. By default, ReVeal WinCOM displays the records in the AT2500’s 
Traces directory. Browse to the correct directory on the AT2500 before you select a record. 

 
 

To copy files to your computer from the remote analyzer: 
 

1.    Log on to an AT2500 series analyzer (see section 2.6.1 on page 2-8). 
 

2. In the left pane, select the destination directory for your local files. By default, ReVeal 
WinCOM opens the \VeEX Telecom directory. To go to another directory, use the drop 
down window or use the File menu to choose Select Folder, Parent Folder or New Folder. 

 

3. Browse to the appropriate directory on the AT2500. To display the directories, use the 
drop down box in the Remote Files pane on the right side of the window. 

 

4. Select a record from the right pane, and then drag it to the left pane, or click Receive in the 
toolbar. You can also select Copy from the Edit menu. This step may be repeated for each 
record or for multiple records transfer, proceed to the next step. See Figure 3-1. 

 

5. Multiple records may be selected in the Remote files (right pane) by holding down the 
Shift and/or Ctrl key on the computer and clicking on the records you want transferred 
over. Once selected, either drag and drop the records or click on Receive in the toolbar to 
transfer them If you want to copy all the records at one, click Receive all in the toolbar. 
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Figure 3-1: Dragging a Record from a Remote AT2500 to the Computer 
 
 
 

To copy files from your computer to the remote AT2500 analyzer: 
 

1. Log on to an AT2500 series analyzer (see section 2.6.1 on page 2-8). 
 

2. In the right pane, select the directory on the remote AT2500 where you want to store the 
record. See Table 3-1 on page 3-2 for a list of directories that the AT2500 uses to store 
records. 

 

3. Browse to the appropriate directory on the AT2500. To display the directories, use the 
drop down box in the Remote Files pane on the right side of the window. 

 

4. Select a local record from the left pane, and then drag it to the right pane, or click Send in 
the toolbar. You can also select Copy from the Edit menu and then select Paste when your 
cursor is in the Remote Files pane. This step may be repeated for each record, or for 
multiple records transfer, proceed to the next step. 

 

5. Multiple records may be selected in the local pane by holding down the Shift and/or Ctrl 
key on the computer and clicking on the records you want transferred over. Once selected, 
either drag and drop the records or click on Send in the toolbar to transfer them 
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3.4 Selecting  a Database (AT2000 series) 

 

The following sections apply to the AT2000 series analyzer and the WinCom user interface. 
See section 3.2 on page 3-3 if you are using an AT2500 series analyzer. 

 
3.4.1 Opening a Records Database 

 
A Records Database file is an AT2000 format file, named RECORDS.BIN on the AT2000. It 
contains trace records such as captured analyzer traces and the analyzer settings corresponding 
to the trace. The number of traces that can be stored in a Records Database file is limited to 100 
or 200 trace records, depending on the storage capabilities of your AT2000 model. 

 

To open a Records database on a remote analyzer: 
1.    Connect to an AT2000 analyzer. See section 2.6.1 on page 2-8 to log on. 
2.    WinCom detects a connection with an AT2000 analyzer and opens the WinCom interface. 

The current Records Database file is displayed in the Traces pane on the right. You can 
now click on a record and view its properties, delete it, or copy it to your computer. 

 

If you already have record database files stored on your computer, you can also open one of 
these files for editing. 

 

To open a Records database if you are offline: 
1.    If you are not already in WinCom, go to the ReVeal WinCOM Tools menu and select 
Launch 

WinCom. This opens a separate window for WinCom. 
2.    In WinCom, go to the File menu and select Open. Select a file that has the extension .BIN 

and click Open. 
 

Note:  By default, WinCom calls up the list of files in the \VeEX Telecom\Databases directory. 
If required, browse to another directory to locate the database file you want to open. 

 

 
 

Figure 3-2: Opening a Records Database File 
 

3. Once you click Open, the content of the records database appears in the right pane. You 
can now click on a record to view its properties or to delete it. You can also copy files in 
this records database to a WinCom database. See section 3.3 starting on page 3-3 for 
information on copying records and updating files. 
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3.4.2 Opening a WinCom Database 

 
The WinCom database file is used for archival storage of AT2000 traces on the PC. It does not 
have a trace count limitation. It can be used for long-term storage of traces from multiple 
AT2000s. You can select trace records and convert then to a records database file that can then 
be uploaded to any AT2000 providing that you do not exceed the storage capacity of the 
AT2000. 

 

Note:  You do not have to be connected to an analyzer in order to open a WinCom database. 
 

To open a WinCom database: 
 

1. In ReVeal WinCOM, go to the Tools menu and select Launch WinCom. This opens 
a new window showing the WinCom interface. 

 

2.    In WinCom, go to the File menu and select Open. Select a file that has the extension 
.WCD, and click Open. 

 

Note:  By default, WinCom calls up the list of files in the \VeEX Telecom\Databases directory. 
If required, browse to another directory to locate the database file you want to open. 

 

 
 

Figure 3-3: Opening a WinCom Database File 
 

3. Once you click Open, the content of the WinCom database appears in the left pane. You 
can now click on a record to view its properties or to delete it. You can also copy one or 
more records to a remote AT2000 if you are already logged on. 
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3.5 Retrieving and Updating  Traces (WinCom) 
 

The Update and Retrieve options in the Communication menu are used to transfer data between 
WinCom and your AT2000 analyzer. You need to be connected to an AT2000 in order to 
transfer records. When you click the Update or Retrieve button, WinCom displays the list of 
files that you can transfer to and from the remote analyzer (see Figure 3-4). 

 

 
 

Figure 3-4: Selecting Files for the AT2000 Series Analyzer 
 

To copy a file from the remote analyzer to WinCom: 
 

1.    Log on to an AT2000 series analyzer (see section 2.6.1 on page 2-8). 
 

2. Click on Retrieve in the WinCom database file management window (see Figure 3-5 on 
page 3-8). 

 

3. In the file selection window (see Figure 3-4), open the file on the remote analyzer that you 
want to retrieve. By default, WinCom selects the traces in the records database. However, 
you can select other files such as user parameters, colors, channel plans, etc. 

 

4. Once you have selected the file, click OK. In the Save As window, choose a file name and 
directory. WinCom saves the file with the correct file extension according to the type of 
data you have selected. See Table 3-1 on page 3-2 for a list of files and their extensions. 

 

5.    Click Save to begin retrieving the data from the remote analyzer. 
 

6. For archival storage you may proceed to copy some or all of the desired traces by clicking 
on the copy or copy all buttons to move the traces from the right pane to the left pane of 
the WinCom database. 

 

To copy a trace from WinCom to a remote analyzer: 
 

1.    Log on to an AT2000 series analyzer (see section 2.6.1 on page 2-8). 
 

2. Click on copy to move the traces within the file from the WinCom database content (left 
pane) to the records database (right pane), (see Figure 3-5:  WinCom Database File 
Management Window). The traces selected and copied to the records database will be the 
ones that will get moved over to the remote analyzer. 

 

3. Click Update in the File transfer area in the center of the WinCom screen, or select Update 
from the Communication menu. 

 

4. In the file selection dialog choose the specific file you want to upload to the remote 
analyzer.  You must choose a file with the correct file extension, according to the type of 
data you have selected. See Table 3-1 on page 3-2 for a list of files and their extensions. 
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By default, WinCom selects the traces in the records database file. However, you can 
select other files such as user parameters, colors, channel plans, etc 

 

5.    Click OK to begin copying the traces in the file to the remote analyzer. 
 

Warning:       Any files you upload  from WinCom to the AT2000 will overwrite the files with the same 
name on the remote  analyzer.  Data on the analyzer will  be lost.  This action  cannot  be 
undone. 

 
3.6 Creating and Updating  Database Files 

(WinCom) 
 

WinCom’s Copy Trace options can be used to create and edit records database files and 
WinCom database files without logging on to an AT2000 analyzer. This “offline” mode is 
useful for organizing records in the WinCom database or the records database. Once you are 
ready to transfer files or individual records, log on to an AT2000 series analyzer. The 
analyzer’s current Records Database file appears in the Traces pane on the right. You can now 
add to this remote database by copying traces from the WinCom database to the remote 
AT2000. 

 

To copy traces with WinCom, you need to use the two panes in the main interface: 
WinCom Database Frame      On the left side of the window, the WinCom database pane lists 

the traces in the current WinCom database file. 
Traces Frame                         On the right side of the window, the Traces pane lists the traces 

in the current Records.bin database file on a remote analyzer or 
in a records database file on your computer. If no records 
database is selected, this pane is empty (see Figure 3-5). You 
can add traces to this pane to update a database (see section 3.6 
on page 3-8). 

 

 
 

Figure 3-5:  WinCom Database File Management Window 



Chapter 3 
File Management 3-9  

 
 

3.6.1 Creating and Updating  a Records Database File 
 

You can use stored records on your computer to create or update a records database file. This 
new or updated database file can then be uploaded to a remote analyzer when you are ready. 

 

To create or edit a records database file: 
 

1.    Open the records database (see section 3.4.1) or the WinCom database (see section 3.4.2) 
that contains the records you want to include in your new or updated records database. 

 

2. Select a record from the right pane (WinCom Database), and then click Copy. If you are 
editing a records database, you can also remove records. First, select the record(s) in the 
right pane then press Delete on your keyboard, or click the Delete button in the right pane. 
The records in your new records database appear on the right in the Traces pane. These 
records are stored in volatile memory until they are saved. 

 

Note:  To select multiple records,  press the Shift key or the Ctrl key before you click  Copy or 
Delete. 

 

3.    Repeat step 2 until you have all of the records you need in the list of traces. 
 

4.    Save your changes. 
• To save the new records database file, go to the File menu and select Save, then 

Records Database. Choose a name for the file and click OK. You must keep the 
extension .bin. 

• To save changes to an updated records database, select Save As, then choose the 
name of your existing records database. Confirm the update by selecting Yes when 
you are asked if you want to overwrite the existing file. 

 
3.6.2 Creating and Updating  a WinCom Database File 

 
You can use stored records on your computer to create a new WinCom database file or add to 
an existing WinCom database. When no WinCom database file has been specifically opened, 
an empty untitled database is created. 

 

To create or edit a WinCom database file: 
 

1. Open a records database (see section 3.4.1) that contains the records you want to include in 
your new WinCom database. 

 

2. Select a record from the right pane (Records Database), and then click Copy. If you are 
editing a WinCom database, you can also remove records. First, select the record(s) in the 
left pane then press Delete on your keyboard, or click the Delete button in the left pane. 
The records now appear in the left, in the WinCom database file content pane, as an 
untitled database. These records are stored in volatile memory until they are saved. 

 

Note:             To select multiple records,  press the Shift key or the Ctrl key before you click  Copy or 
Delete. To copy  records  from  more  than  one records  database  file,  close  the current 
records  database first  and then open another  one. Repeat step 2 until  you have all the 
records you need. 

 

3.    Repeat step 2 until you have all of the records you need for your WinCom database. 
 

4.    Save your changes. 
• To save the new WinCom database file, go to the File menu and select Save, then 

select WinCom Database. Choose a name for the file and click OK. You must keep 
the extension .WCD. 

• To save changes to an updated WinCom database, select Save As, and then choose 
the name of your existing WinCom database. Confirm the update by selecting Yes 
when you are asked if you want to overwrite the existing file. 
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3.7 Viewing and Editing  Record Properties 
(WinCom) 

 

The AT2000 Properties for traces can be viewed and edited with WinCom. The properties 
include the analyzer’s mode, site ID, comments, and the date and time that the trace was 
captured. The properties appear as they were entered on the analyzer from which the trace 
originates. A description of the abbreviated analyzer modes appears at the end of this section. 

 

 
 

Figure 3-6: Viewing the Properties of a Record 
 

To view or edit the properties of a trace: 
 

1.    Select the trace in the WinCom database or in the records database. 
 

2. Click the Properties button in the appropriate pane: left pane for WinCom database, right 
pane for records database. 

 

3. If desired, edit the user-definable fields.  If the record is in a WinCom database, all fields 
except Mode, Date and Time can be edited. If the record is in a records database, only the 
Site ID and Comments fields can be edited. See Table 3-2 for a description of the analyzer 
modes. 

 

Editable Field  Format 
 

Site ID Up to 8 characters 
Comments Up to 40 characters 
User ID Up to 40 characters 
Company Up to 40 characters 

4. Click OK to save your changes, or just click Close to exit the Properties window without 
making any changes. 
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Table 3-2: Abbreviated Analyzer Modes Stored in Trace Records 
 

Mode  Description 
 

SA Spectrum Analyzer Trace 
TDM Time Domain Measurement Trace 
SLM1                       Signal Level Meter Bar Graph (Frequency Counter) 

SLM2                       Signal Level Meter Bar Graph (TV Channel Mode) 
SLM6                       Signal Level Meter Bar Graph (6 channels) 
HUM Hum Modulation Trace 
DIST Distortion Trace 
AUTO Auto Test 
DPWR Digital Power 
QAM QAM Trace 
BAS Bidirectional Alignment Trace 
DM Depth of Modulation 
FR Frequency Response 

 
VID Video 



 

 



 

 

 
 
 

Chapter 4 TRACEVIEW 

4-1 

 
ReVeal WinCOM’s built-in charting utility, TraceView, utilizes your PC to display the data 
collected with the analyzer. You can view any .XML trace file in ReVeal WinCOM or you can 
open a database in WinCom that contains captured traces and double-click on a trace record to 
open the TraceView utility. 

 

Once you have called up a trace, you can analyze data, print various reports or export 
measurement data directly to several formats such as .BMP or .CSV. For AT2500 series traces, 
the traces can be exported directly from TraceView to proof of performance reports such as 
VeEX PoP (.CSV) or FamilyWare (.TSD). For AT2000 traces, you must first export the 
traces to an ASCII file (.CSV), and then import this file into the VeEX preformatted Excel file 
(VeEXPoPMacros.xls) that includes macros for formatting data from .CSV files. 

 

This  chapter  explains  the functions  for  analyzing,  printing  and  exporting  data from the 
TraceView utility. 

 

 
 

4.1 Viewing Trace Records 
 

You can call up a trace record in either WinCom or ReVeal WinCOM. WinCom opens 
records captured with the AT2000 series analyzer in the 1 MHz to 1 GHz range, whereas 
ReVeal WinCOM opens .XML records captured with the AT2500 series analyzer in the 1 MHz 
to 1.5 GHz range. 

 

 
 

4.1.1 Viewing AT2000 Traces 
 

To view traces that were captured with an AT2000 series analyzer, you need to launch 
WinCom before you can use the TraceView utility. 

 

1.    In ReVeal WinCOM, go to the Tools menu and select Launch 
WinCom. 

 

2. Use the File menu and open any records file (.BIN) or database file (.WCD) that contains 
traces. 

 

3.    Double click on a trace in the file to open the TraceView utility and display the trace. 
 

4. To view another trace from the same records file or database file, select Recall Records 
from the View menu to display the list of records in the most recently opened file.  If the 
toolbar is displayed, you can click the Recall button. 

 

5. To open a trace from a different file, select Open Database from TraceView’s File menu, 
and then select a records file (.BIN) or database file (.WCD). When the list of records 
appears, select a trace and click Display to view it in the TraceView window. 

 
 
 

4.1.2 Viewing AT2500 Traces 
 

To view traces that were captured with an AT2500 series analyzer, use ReVeal WinCOM’s 
View menu. This opens the Trace View utility. 

 

1.    In ReVeal WinCOM, browse to the directory where your traces are 
stored. 

 

2. Highlight any .XML file that is a trace. If the trace you would like to view is that of a 
video trace (ie. a trace with the file extension .vid.xml, then proceed to section 4.3.6 on 
page 4-9. 

 

3.    Go to the View menu and select Trace. 
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Note:  You can also click the View button  or simply  press F7 on your keyboard  when the trace 

is selected. 
 

If the .XML trace file being viewed is that of a multiple trace display, one can turn on and 
off, each of the 4 possible traces within the display, by selecting the trace and checking on 
the trace to display and checking off the trace to hide. See Figure 4-1 below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-1: Viewing multiple traces 
 

 
 

In addition, if the Multi Trace Bar is checked on, the displayed file will reveal the bar 
allowing the user to select via the individual trace buttons, which of the multiple traces is 
to be displayed. See Figure 4-2 below. 

 

 
 
 
 
 

Figure 4-2: Multi trace bar 
 

4.    To view another trace file, go back to ReVeal WinCOM’s main window and highlight a 
different 

.XML file. Do not use the recall button unless you want to view a trace captured with an 
AT2000 series analyzer. 

 
 
 
 
 

4.2 Spectrum  Analyzer Instrument Settings 
 

In order to help you analyze the information that is on screen, the ReVeal WinCOM software 
provides control over many spectrum analyzer display parameters when you are viewing a 
trace. For example, you can change the units of measure or set markers. However, the changes 
you make to the display parameters only apply to ReVeal WinCOM’s TraceView. None of the 
stored traces are affected, and no new settings are saved with the trace. 

 

This section explains how to change certain display settings for a trace, such as: 
• vertical scale 
• reference level 
• markers 

 
 
 

4.2.1 Vertical Scale 
 

ReVeal WinCOM displays traces on a graticule with 10 dB per division. You can, however, 
change the scale on the vertical axis of the graticule in order to zoom in on the signal. 
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To change the vertical scale: 

 

1.    Go to the Setting menu and select Vertical Scale. 
 

2. Choose how many decibels per division you want to use. Each division can be 2 dB, 5 dB, 
or 10 dB. 

 

3.    Click OK to view the trace with the new vertical scale settings. 
 

When you change the vertical scale, ReVeal WinCOM repositions the signal. For example, 
if you chose a smaller scale, ReVeal WinCOM hides the upper and lower portions of the 
signal. You may also want to change the reference level in order to view a particular 
portion of the signal. Note that the reference level choices reflect the number of decibels 
per division. 

 

 
 

4.2.2 Reference Level 
 

When ReVeal WinCOM displays a trace, it uses the same reference level that was active on 
the spectrum analyzer when the trace was captured. However, if you change the vertical scale, 
you may need to change the reference level in order to view a specific portion of the signal. 

 

To change the reference level: 
 

1.    Go to the Setting menu and select Reference Level. 
 

2. Choose the reference level from the drop down list. The choices that are available reflect 
the vertical scale you are using and the upper and lower limits of the spectrum analyzer 
display at the time the trace was captured. For example, if you have selected a 2 dB per 
division scale, then you can set the reference level in steps of 2 dB. 

 

3. Click OK to apply the new reference level. When you change the reference level, 
ReVeal WinCOM repositions the signal. If you do not see the portion of the signal 
you are interested in, select another reference level. 
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4.2.3 Markers (vertical,  horizontal, peak, and tilt) 
 

View Marker Bar 
 

If you use markers frequently, you can display the marker toolbar that provides shortcuts to 
activating the vertical and horizontal markers. To display this toolbar, go to the Settings menu 
and select View Marker Bar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-3: Settings menu 
 

When a checkmark appears next to this option, the feature is active and the marker bar will 
appear as in the figure below. To hide the marker bar, go back to the Settings menu and select 
View Marker Bar again. The checkmark disappears, indicating that the marker bar is now 
disabled. 

 
 
 
 
 

Figure 4-4: Marker bar 
 
 

Markers (Vertical,  Horizontal and Noise) 
 

ReVeal WinCOM includes two vertical markers, two horizontal markers and a noise marker 
to set level and frequency references. The vertical V1 and V2 markers indicate the frequency 
and in certain appropriate spans, the level is also displayed. When both vertical markers are 
selected and displayed on the screen, the frequency and level deltas are automatically 
calculated. Instead of marker V2, you can choose to use the noise marker. When the noise 
marker is selected, ReVeal WinCOM displays the noise in dB per Hz of the selected frequency. 

 

When both horizontal markers are displayed on screen, ReVeal WinCOM automatically 
calculates the delta levels, which can be useful for peak-to-valley measurements 

 

To turn on a marker: 
 

1. Go to the Settings menu and select a marker: Marker V1, Marker V2, Marker H1, Marker 
H2 or Noise Marker. You can activate both vertical markers and both horizontal markers 
at the same time, but you cannot activate the Noise Marker at the same time as Marker V2. 
Alternatively, the marker bar can be used to activate the markers by selecting the marker 
buttons. When used in association with a multiple trace display, one can select the specific 



Chapter 4 
TraceView 4-5  

 
trace for which the markers are being used, via the drop down menu next to the vertical 
marker buttons. 

 

2. A checkmark appears next to the active marker(s). To disable a marker, go back to the 
Settings menu and select the marker again. The checkmark disappears, indicating that the 
marker is now disabled. Alternatively, if the marker bar was being used, select the marker 
again to disable it. 

 

3. Set your markers to the desired position by using the scroll bars at the bottom and on the 
right side of the screen (see next section). 

 
Marker Scroll 

 

The Scroll Marker choices in the Settings menu let you choose which marker is moved when 
you use the vertical or horizontal scroll bars at the bottom or on the right side of the screen. 

 

This feature is only active when you are using the associated marker. By default, ReVeal 
WinCOM activates the scroll function on the first marker you select. You can activate the 
scroll function on one vertical marker and one horizontal marker at the same time, but you 
cannot activate the scroll function on both vertical markers or on both horizontal markers. 
When the marker bar is being used, the scrolling function will only apply to the marker which 
has the small bullet icon next to it. 

 

To activate the scroll function on markers: 
 

1.    Activate one or more markers (see preceding section). 
 

2. Go to the Settings menu and activate the scroll function on a marker: Scroll Marker V1, 
Scroll Marker V2, Scroll Marker H1 or Scroll Marker H2. A small bullet appears to the 
left of the menu choice to indicate which marker you are moving when you use the scroll 
bars. 

 

3. To disable scrolling on a marker, either disable the marker or activate the scroll function 
on another marker of the same type. For example, to disable scrolling of marker V1, select 
Scroll Marker V2. ReVeal WinCOM automatically disables the scroll function on Marker 
V1. 

 

4. Use the vertical or horizontal scroll bars to move the associated marker. For vertical 
markers, use the scroll bar at the bottom of the screen. For horizontal markers, use the 
scroll bar on the right side of the screen. The signal remains centered in the window. 

 

5. A user may also input a preset delta value between the two vertical markers by selecting 
the V1-V2 delta option in the Settings menu, or selecting the Delta button in the marker 
bar. Either mode of selection will bring up the following dialog as shown in the figure 
below.  The delta option allows the user to lock V2 to V1 at a specific frequency delta or 
offset so that both markers move together. 

 
 
 
 
 
 
 
 
 

Figure 4-5: Tracking Delta dialog 
 

6. The Track button must be toggled on so that the delta frequency between V2 and V1, 
defined in the previous step, establishes the locking of V2 to V1. Alternatively, the user 
may select the V2 tracking with V1 selection in the Settings menu to achieve the same 
functionality. When the scroll bar at the bottom of the screen is used, V2 and V1 will scroll 
together, with the delta frequency set between them, maintained. To disable the tracking of 
V2 to V1, click on the Track button to toggle off the functionality, or alternatively toggle 
off the V2 tracking with V1 selection in the Settings menu. 
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Peak Search Marker 
 

The peak marker may be used to identify the various peak levels for a specific trace. 
 

1. Go to the Settings menu and select the Peak Marker menu item, and then select the View 
Peak Search Bar menu item. Alternatively, the Peak Search Bar may be activated by 
selecting the menu item from the View menu. In either case, a check mark appearing next 
to the Peak Search Bar menu item indicates that this feature is active and will appear as in 
the figure below. 

 
 
 
 
 
 

Figure 4-6: Peak Search Bar 
 

2. Select the Positive or Negative peak search option within the Peak Search Bar. The small 
bullet will appear next to the active mode. 

 

3. Select the First Peak button to select the highest peak when in the Positive mode, and the 
lowest peak in the Negative mode. 

 

4. Select the Next Peak Left to find the next peak to the left of the current peak. 
 

5. Select the Next Peak Right to find the next peak to the right of the current peak. 
 

 
 
 

Tilt Marker 
 

1.    Go to the Settings menu and select the Tilt Marker menu item, and then select the View 
Tilt Marker Bar menu item. Alternatively, the Tilt Marker Bar may be activated by 
selecting the menu item from the View menu. In either case, a check mark appearing next 
to the Tilt Marker Bar menu item indicates that this feature is active, and will appear as in 
the figure below. 

 
 
 
 
 

Figure 4-7: Tilt Marker Bar 
 

2. Within the Tilt Marker Bar, select the Tilt Marker Shown button to show the active tilt 
marker. 

 

3. Select the Tilt Low Freq button to set the low frequency reference value in the dialog that 
appears. 

 

4. Select the Tilt High Freq to set the high frequency reference value in the dialog that 
appears. 

 

5. Select the Low Freq Level to set the low frequency level (in dBmV) reference value in the 
dialog that appears. 

 

6. Select the Tilt Offset to set the desired tilt level (in dB) reference value. 
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4.3 Defining  Custom Settings  for TraceView 

 

TraceView can be customized so you can use the colors, temperature units and other units of 
measure that you want to. You can also show or hide toolbars. 

 

This section explains how to change the settings of: 
• colors 
• temperature units 
• display units 
• toolbar display 

 
 
 

4.3.1 Customizing the TraceView Colors 
 

The color of the items displayed in TraceView can be customized to help you view and print 
the captured data. 

 

To select a color scheme or custom colors: 
 

1. Select Colors from the TraceView Options menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-8: Choosing Color Options 
 

2. Choose one of the four predefined color schemes: 
 

Scheme  Description 
 

Factory Default                     This is the factory default color scheme, and is similar to 
the default indoor colors used on the spectrum analyzer. 

B/W                                      This is a black and white color scheme. When printing on 
monochrome printers, a black and white scheme may be 
most suitable. Dark areas are minimized in order to 
conserve toner or ink. 

Color Saving                         This scheme limits the use of colors. It uses some color for 
traces, gridlines and markers while keeping everything else 
black and white to conserve toner or ink when printing. 

Custom                                 This is a user-defined custom color scheme. Selecting this 
option restores the custom settings that were saved. Only 
one custom scheme can be saved in ReVeal WinCOM. 
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3. If you want to use your own color scheme, start with the color scheme that is closest to 

what you want to use, and edit the component(s). The current color appears in a small box 
next to the item. To change this color, click on the item and select a new color from the 
choices. You can also create custom colors instead of choosing a predefined color. 

 
There are eight editable screen components: 

 
Component  Description 

 
Graphic Background             This is the color of the graticule’s background. Choose a 

color that allows enough contrast with the grid lines, traces, 
markers and thresholds. 

Grid Lines This is the color of the dotted grid lines. 
Text This is the color of the text that appears outside of the 

graticule. 
Background                          This is the color of the margin around the graticule, where 

text is shown. Choose a color that allows enough contrast 
with the text color. 

Trace This is the color of the captured trace or QAM signal. 
Markers This is the color of the vertical and horizontal markers and 

the zoom marker in QAM mode. 
Trace2 This is the color of the second trace. 
Trace3 This is the color of the third trace. 
Trace4 This is the color of the fourth trace. 
Thresholds This is the color of the limit lines. 

 
 

4.      Once you have made your changes, click Save Custom to record your color scheme. 
 

 
 

4.3.2 Choosing a Temperature  Unit 
 

The data captured with the spectrum analyzer includes the ambient temperature when the trace 
was captured. You can choose either Fahrenheit or Celsius in TraceView. 

 

To change the temperature units: 
 

1. Go to the Options menu and select Temperature Units to display the choices. A small 
bullet appears to the left of the menu choice to indicate which temperature unit is currently 
in use. 

 

2. Select either Celsius or Fahrenheit. When you release the mouse, the TraceView display is 
updated with the new temperature units. 

 

 
 

4.3.3 Display Units 
 

The vertical axis on data captured with the spectrum analyzer is usually in dBmV (decibel 
referenced in a millivolt). You can change the units on the vertical axis to dBµV (decibel 
referenced in a microvolt) through TraceView’s options menu. 

 

To change the display units: 
 

1.  Go to the Options menu and select Display Units to display the choices. A small bullet 
appears to the left of the menu choice to indicate which temperature unit is currently in 
use. 
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2. Select either dBmV or dBµV. When you release the mouse, the TraceView vertical axis is 

updated with the new units. 
 

4.3.4 Setting the Date Format 
 

The data captured with the spectrum analyzer includes the date the trace was captured. You can 
choose between long and short International formats (day, month, year) or US long and short 
formats (month, day, year). To change the date format, see section 2.6.2 on page 2-9. Once you 
change the format, TraceView updates the date display on any traces that you are viewing. 

 
 
 

4.3.5 Using the TraceView Toolbar 
 

The Toolbar item controls whether or not the toolbar is displayed. The Toolbar provides quick 
access to frequently used commands. 

 

To display the toolbar: 
 

1.    Go to the View menu and select Toolbar. 
 

2. A checkmark appears to the left of this menu item to indicate that it is active, and the 
TraceView toolbar buttons (Open, Recall and Exit) appear in the upper part of the 
window. To hide the toolbar, select the Toolbar item again. The checkmark should 
disappear as well as the buttons. 

 
 
 

4.3.6 Viewing Video Traces 
 

This section has been included in the manual to differentiate all other trace displays from those 
of video traces (trace files with the .vid.xml extension), due to differences in the toolbar 
selections and the overall difference in look and feel for displayed video traces. 

 

1.    In ReVeal WinCOM, browse to the directory where your traces are 
stored. 

 

2. Highlight a .vid.xml file that is a video trace. The captured video trace may be that of a 
waveform monitor display as in Figure 4-9 or a vectorscope display as in Figure 4-10. 

 

3.    Go to the view menu and select Trace. 
 

Note:             You can also click the View button  or simply  press F7 on your keyboard  when the trace 
is selected. Alternatively, double-clicking the left mouse button will allow you to view the 
trace. 

 
 

4. Proceed to step 5 if the video display is that of a waveform monitor, or to step 10 if the 
video trace is that of a vectorscope display. 
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Figure 4-9: Viewing a video trace (waveform monitor) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-10: Viewing a video trace (vectorscope view) 
 

 
 

5. To enable or disable the individual options available for a given video trace (waveform 
monitor), ensure that the options under the View menu item have been checked on or off, 
respectively. The options included for viewing are Settings, Markers, Measures  and 
Information. The tab for the specific option will appear on the upper right hand side, next 
to the video trace. 

 

6. Click on the Settings tab to view general and specific waveform settings for the stored 
video trace. As well, it can be determined if the Zoom feature was active when the trace 
was stored by the appearance or absence of a checkmark within the box. 

 

7. Click on the Measures tab to view measurement results for Y/C luminance chrominance 
delay and gain, Depth of Modulation (if selected at time of measurement), Modulation 
Linearity (if selected at time of measurement), Signal to Noise. 

 

8. Click on the Markers tab to enable the individual horizontal (H1 and H2) markers, as well 
as the individual vertical (V1 and V2) markers. The delta value for the horizontal markers 
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will become visible when both H1 and H2 markers are enabled. As well, the delta value 
for the vertical markers will become visible when both V1 and V2 are enabled. 

 

9. Click on the Information tab to view specific information regarding the trace and 
additional parameters regarding the analyzer which captured the trace. 

 

10.  To enable or disable the individual options available for a given video trace (vectorscope 
display), ensure that the options under the View menu item have been checked on or off, 
respectively. The options included for viewing are Settings, and Information. The tab for 
the specific option will appear on the upper right hand side, next to the video trace. 

 

11.  Click on the Settings tab to view general and specific settings for the stored video trace in 
the vectorscope display 

 

12. Click on the Information tab to view specific information regarding the trace and 
additional parameters regarding the analyzer which captured the trace. 

 
 
 

4.3.7 Customizing the Video Trace Colors 
 

1. In the Options menu of a video trace, select Colors. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-11: Choosing color options for video traces 
 

2. Choose one of three defined color schemes:   
 

Scheme  Description 
 

Factory Default This is the factory default color scheme, and is similar to 
the default indoor colors used on the spectrum analyzer. 

B/W This is a black and white color scheme. 
Custom This is a user-defined custom color scheme. 

 
 
 
 

3.  If you want to use your own color scheme, start with the color scheme that is closest to 
what you want to use your own color scheme that is closest to what you want to use, and 
edit the components. The current color appears in a small box next to the item. To change 
this color, click on the drag down button appearing to the right of the color selection. 

 

4. Choose one of the three color palettes, namely; Custom, Web, System. 
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5. Select a color from within the chosen palette. Alternatively, you may simply overwrite the 

color that appears and type in the name of the color you would like to you use. 
 

There are nine editable screen components. 
 
 

Component  Description 
 

Background                          This is the color of the margin around the graticule, where 
text is shown. Choose a color that allows enough contrast 
with the text color. 

Border This is the color of the graph border color. 
Chart(Graph)Background This is the color of the chart (graph) background. 
Grid Line This is the color of the dotted grid lines. 
Highlighted Marker               This is the color of the marker which is highlighted when 

the cursor is passed over it. 
Highlighted Trace                 This is the color of the trace which is highlighted when the 

cursor is passed over it (ex. a Vectorscope display which 
can be manipulated). 

Marker This is the color of the marker. 
Scale Text This is the color of the chart text. 
Trace This is the color of the trace. 

 
 
 
 

4.4 Viewing QAM Data 
 

You can call up a QAM record in either WinCom or ReVeal WinCOM. WinCom opens 
records captured with the AT2000 series analyzer in the 1 MHz to 1 GHz range, whereas 
ReVeal WinCOM opens .XML records captured with the AT2500 series analyzer in the 1 MHz 
to 1.5 GHz range. 

 

Once you have called up a QAM record, you can change viewing options (see section 4.3 
starting on page 4-7) and print the record (see section 4.5 on page 4-17) just like any trace 
record. In addition to these standard features, ReVeal WinCOM offers extra controls for 
analyzing QAM records, as described in this section. 

 
4.4.1 Zooming  in on a Constellation 

 
You can zoom in on a portion of the QAM constellation once you call up a QAM record. 

To zoom in on a QAM constellation: 

1.      Call up the QAM constellation you want to view (see section 4.1 on page 4-1). 
 

2. Move your mouse to mark any frame of the constellation. To zoom in, click the left mouse 
button once. 

 

3.      To keep zooming in, repeat step 2. 
 

4.      To zoom out, click the right mouse button. 
 

5.      To keep zooming out, repeat step 4. 
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Figure 4-12: Viewing QAM Constellation 
 
 

4.4.2 Viewing Statistical Data 
 

If you are viewing QAM statistical data that was captured over a period of time with the 
spectrum analyzer, you can zoom in on a particular time. 

 

To view statistics for a particular time: 
 

1. Call up the trace or QAM image you want to print (see section 4.1 on page 4-1). 
 

2. In the top part of the window, use the Screen Width field to change the window you are 
observing. By default, ReVeal WinCOM displays the full statistical period. 

 

3. In the Go To field, enter the elapsed time that you want to view. For example, if the 
statistics were taken over 2 minutes, you can view the statistics at the one-minute mark. 
Use the plus and minus buttons to scroll forward and backward in time. 

 

 
Figure 4-13: Viewing QAM Statistics 
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4.4.3 Viewing the Adaptive  Equalizer Display 

You can view the adaptive equalizer display once you call up a QAM record. 

There are three different displays in the equalizer screen: 
• A bar graph showing the 32 coefficients: 8 feed-forward Equalizers (FFE) and 24 

Decision Feedback Equalizers (DFE). The eighth coefficient is the main signal path 
so it is normally very close to 0 dB (unity gain) 

• A frequency response graph (from +5 to –3 dB) over the defined channel bandwidth. 
• A group delay graph showing the delay in nsec across the channel bandwidth. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-14: Viewing the Adaptive Equalizer Display 
 

Each of the three displays can be viewed individually by placing the cursor over the desired 
display and clicking the left mouse button. Once the specific display is chosen, an enlarged 
view will be presented. To return to the combined view, simply click on the right mouse button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-15: Equalizer Display 
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When selecting the frequency response graph, vertical and horizontal markers are available to 
perform specific measurements such as peak to valley of the frequency response plot, as shown 
below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-16: Frequency response display (with horizontal markers selected) 
 

 
 

When selecting the group delay graph, vertical and horizontal markers are available to perform 
specific measurements. When both the vertical V1 and V2 markers are used, the delta values in 
both frequency and time are displayed. Additionally, the slope of the curve between marker 
points is indicated in ns/MHz. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-17: Group delay display (with vertical markers selected) 
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4.4.4 Using the QAM Mode Toolbar 

 
The QAM Bar item controls whether or not the QAM toolbar is displayed. The QAM toolbar 
provides quick access to the Export command. 

 

To activate the QAM toolbar: 
 

1. Go to the View menu and select QAM Bar. 
 

2. A checkmark appears to the left of this menu item to indicate that it is active, and the 
QAM toolbar buttons (Mode, Filter, Disable Grid, Disable Template, Setup and Export) 
appear in the upper part of the window. Only the Export button is active. If you are 
viewing a QAM constellation or statistical data captured with the spectrum analyzer, click 
Export to save the data in an ASCII file. See section 4.6 on page 4-19 for detailed 
instructions. 

 

Note:             You cannot  export  QAM data to VeEX  PoP (.CSV) or FamilyWare  (.TSD). You can, 
however,  export  the image to a .BMP format  for use as an image in another  application 
(see section 4.6.4 on page 4-21). 

 

3. To hide the toolbar, select the QAM Bar item again. The checkmark should disappear as 
well as the buttons. 
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4.5 Printing Reports and Screens 
 

Once you have set up your printer, you can print any image on your screen. You can also tag 
multiple records and print them all at once. 

 

 
 

4.5.1 Defining  the Print Setup 
 

ReVeal WinCOM’s Print Setup lets you choose the target printer, set up its properties, select 
paper size, paper source, and page orientation. 

 

To set up your printer: 
 

1. From TraceView’s File menu, select Print Setup. 
 

 
 

Figure 4-18: Setting up a Printer 
 

2. Once you have made your changes, click OK to record your setup. ReVeal WinCOM 
will use this setup when you print an image (see section 4.5.3). 

 

 
 

4.5.2 Using the Print Preview 
 

ReVeal WinCOM’s Print Preview displays the image the way it will appear when printed. 
Use this preview to verify the image and page settings before printing. 

 

To preview a trace before printing: 
 

1. Call up the trace you want to view (see section 4.1 on page 4-1). 
 

2. From TraceView’s File menu, select Print Preview. The trace now appears on screen. 
 

3. From the Preview mode, you can print the trace by selecting the Print button, or zoom in 
on a portion of the image using the Zoom In button. To exit the Print Preview, click the 
Close button. 
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4.5.3 Printing a Screen 

 
To print the image on your screen: 

 

1. Call up the trace or QAM image you want to print (see section 4.1 on page 4-1). 
 

2. Go to the File menu and select Print. ReVeal WinCOM immediately sends the data to the 
printer that is defined in your printer setup. To change the printer setup, see section 4.5.2. 

 
 
 

4.5.4 Printing Multiple  Records 
 

To print multiple records from a WinCom database or records file: 
 

1. From ReVeal WinCOM, launch WinCom. 
 

2. Open the WinCom database or the records file containing the traces that you want to print. 
See section 3.4 on page 3-5 to select a database or records file. 

 

3. In the Select Trace window, tag the records in the WinCom database or the records file 
that you want to print as follows: 
• To select a few records in the file, check the box in the Print column. Adjust the 

column width if necessary until you see the Print column. You can click on any 
column to sort the records, for example, by date or mode. 

• To select all of the records in the file, click Tag All. To change your choice, click 
Untag All. 

 

 
 

Figure 4-19: Printing Tagging Records 
 

4. Once you have selected the records, click Print Tagged. WinCom sends the data to the 
printer that is defined in your printer setup. To change the printer setup, see section 4.5.1. 
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4.6 Exporting Data 
 

The data you capture with a VeEX spectrum analyzer includes the model and serial number, 
most recent factory calibration date of the instrument as well as basic information such as date, 
time, temperature, company name and user name. This data is stored with the trace and is 
transferred to WinCom or ReVeal WinCOM when you download files from the spectrum 
analyzer. The measurement results can then be exported directly into several formats: 

•    a comma separated value (.CSV) file format for use in a spreadsheet program 
•    a .BMP file to be pasted into another application 
•    a VeEX POP format 
•    a .TSD file on your PC, that is then imported into FamilyWare 

 
Important:  For FCC exports,  make sure you enter the site ID in the spectrum analyzer in the correct 

format so that software can recognize the formatting and populate the proper cells. 
 

4.6.1 Exporting a Single Trace to ASCII Format (CSV) 
The Export in ASCII function converts data into a comma delimited text file (CSV) format that 
can be imported into spreadsheet programs. If you use Excel, you can make use of VeEX’s 
proof of performance (POP) macro, included with ReVeal WinCOM. 

 

To export a single trace to an ASCII file (CSV format): 
1.    Call up the trace you want to export (see section 4.1 on page 4-1). 

 

2. From TraceView’s File menu, select Export in ASCII (CSV) format. Browse to the 
directory where you want to save the trace in ASCII format. 

 

3.    Choose  a  name  for  the  file  and  click  Save.  ReVeal WinCOM  adds  the  extension  
.CSV 

automatically unless you select another format. 
 

4.    Open the file in a spreadsheet program and use its charting functions to analyze the data. 
You can also open the VeEX preformatted Excel file (VeEXPoPMacros.xls) that includes 
macros for formatting data from .CSV files. Once you are in the VeEX preformatted 
Excel file, you can import your .CSV files. 

 
4.6.2 Exporting Multiple  Traces to ASCII Format (CSV) 

 
If you want to export multiple traces captured with the AT2000 series analyzer, you need to 
launch WinCom. The TraceView utility only exports one trace at a time. 

 

To export multiple traces from a WinCom database or records file: 
 

1.    From ReVeal WinCOM, launch 
WinCom. 
2. Open the WinCom database or the records file containing the traces that you want to 

export. See section 3.4 on page 3-5 to select a database or records file. 
 

3.    Select the records in the WinCom database or the records file that you want to export. 
 

4.    From WinCom’s File menu, select Export to CSV, and then choose Selected Record 
Traces or Selected WinCom Database Traces. 
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Figure 4-20: Exporting Selected Records to CSV Format 
 

5. In the Select Export Filename window, browse to the directory where you want to save the 
trace in ASCII format.  You can create a new directory by modifying the path shown in 
the Base Filename field. 

 

 
 

Figure 4-21: Saving Exported Files 
 

6. In the Base Filename field, choose a root file name. Each trace that you export will start 
with this root filename. WinCom adds a sequential number such as 0001, 0002, etc. so that 
each exported trace has a unique name. 

 

7. Click OK to begin exporting the files. 
 

4.6.3 Exporting a Channel Plan 
 

In order to use the VeEX Excel Macro FCC POP report, you need to have a channel plan in 
.CSV format. You can export your current channel plan so you can use it in the report. 

 

To export a channel plan: 
1. From ReVeal WinCOM, launch WinCom. 

 

2. From WinCom’s File menu, select Export to CSV, then choose Current Channel Plan. 
 

Note:             If the current  channel  plan  is not  the one you want  to use, change  the channel  plan 
before you export it. To do so, go to the Options  menu and select Current Channel Plan 
File.  Browse to the directory where your channel plan file is located. The file must have 
the extension .PLN. Once you have loaded the correct  channel plan, complete  step 2 of 
this procedure. 

 

3. In the Save As window, browse to the directory where you want to save the exported plan. 
By default, WinCom saves the file as CHANNELPLAN.CSV in the same directory as 
your exported traces. 

 

4. Click Save to export the channel plan. You can now import this plan into the VeEX 
Excel Macro FCC POP report or other spreadsheet program. 
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Important:  For purposes of data integrity, the channel  plan should  be finalized  and 
used throughout the testing cycle. 

 
 

4.6.4 Exporting to the Clipboard (BMP) 
 

This function copies the trace display area to the system clipboard in a bitmap format. This is 
essentially a picture of the trace that can be pasted into other applications such as word 
processing programs. Only one trace can be exported at a time. 

 

To export a trace to the clipboard (.BMP format): 
1.    Call up the trace you want to export (see section 4.1 on page 4-1). 

 

2. From TraceView’s File menu, select Export to clipboard (.BMP format). The image is 
now in your Windows clipboard. 

 
Note:  You must paste the image (Ctrl-V for most applications) before exporting another trace to 

the clipboard (.BMP format). 
 

 
 

4.6.5 Exporting to the VeEX POP Report 
 

The VeEX proof of performance (POP) report accepts multiple traces captured with the 
AT2000 series analyzer. You need to launch WinCom first in order to access this feature. 

 

To export multiple traces from a WinCom database or records file to a VeEX POP report: 
1.    From ReVeal WinCOM, launch 
WinCom. 
2. Open the WinCom database or the records file containing the traces that you want to 

export. See section 3.4 on page 3-5 to select a database or records file. 
 

3.    Select the records in the WinCom database or the records file that you want to export. 
 

4.    From WinCom’s File menu, select Export to VeEX PoP, and then choose Selected 
Record Traces or Selected WinCom Database Traces. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-22: Exporting Selected Records or Traces to VeEX POP Report 
 

 
 

Note:             If there are any records  that need additional formatting information for export  to a TSD 
format,  WinCom  provides a window  to  edit  the  identification for  the  traces.  Choose 
Headend Trace or Test Point Trace and edit the information. Click OK to continue. 
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Figure 4-23: Modifying Identification Data for TSD Format 
 

5. Import or edit the system information. 
WinCom prompts you to import information for your cable system that appears in the 
report header. If you have exported this information into an ASCII format (see section 4.6 
starting on page 4-19) as part of a records database, you can import the SystemInfo.csv file 
now. Click Yes and browse to the directory where your system information is located. The 
file must have the extension .CSV. If you do not have a system information file, you can 
enter the information for the VeEX report header now. 

 

Follow the prompts on screen: 
•    company name 
•    system name 
•    street address (street and municipality) 
•    state or province 
•    ZIP or postal code 
•    number of subscribers 
•    number of integrated hubs 
•    system bandwidth 
•    year of the last triennial test 
•    the number of each test channel (1 to 13) 

 
6. Select a channel plan. 

 

WinCom prompts you for a channel plan. 
•    To use the channel plan that was exported with the records, click Yes. 
• To select a different channel plan for your own exported channel plan files, click No 

and browse to the directory where your channel plan is located. The file must have the 
extension .CSV. If you have not yet exported a channel plan, see section 4.6.3 on 
page 4-20. Select the channel plan and click OK to continue. 

 
7. WinCom now opens the VeEX preformatted Excel file and populates the appropriate 

cells, using the data for your system and the data in the records you selected. 
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4.6.6 Using the VeEX Preformatted Excel File 

 
The VeEX preformatted Excel file (VeEXPoPMacros.xls) includes macros for formatting data 
from .CSV files. This Excel file and its macros run automatically when you export to a VeEX 
POP format. Alternatively, you can open the file from the \VeEX Telecom\Excel Pop Macros 
directory, and then import your .CSV files. 

 

You can view, print, import and export data from this file: 
• To view data, consult each tab in the Excel file to view the summary, headend and 

test point data. 
• To print the page you are viewing, click Print Current Page. You may want to 

preview the page first to check the page layout. To do so, click Preview Current Page 
and make any adjustments as necessary from the preview window. 

• To import more data into this file, click Import CSV files and select a file with the 
.CSV extension. For example, you can import channel plans or more traces. 

• To export the Excel file to a FamilyWare .TSD format, click Export Data to TSD. 
WinCom will prompt you for any additional information that may be required such as 
the channel plan, list of test channels, system information and measurement results. 

• To clear the data in the cells and start over, click Clear Current Page. This does not 
delete the formatting, 
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4.6.7 Exporting to a FamilyWare File (.TSD) 
 

WinCom supports the FamilyWare .TSD format for proof of performance reporting. You can 
export traces directly to this format from WinCom. You need to launch WinCom first in order 
to access this feature. 

 

You can also export data from the VeEX preformatted Excel file to the .TSD format. See 
section 4.6.6. 

 

To export multiple traces from a WinCom database or records file to a VeEX POP report: 
 

1.    From ReVeal WinCOM, launch 
WinCom. 
2. Open the WinCom database or the records file containing the traces that you want to 

export. See section 3.4 on page 3-5 to select a database or records file. 
 

3.    Select the records in the WinCom database or the records file that you want to export. 
 

4.    From WinCom’s File menu, select Export to VeEX PoP, and then choose Selected 
Record Traces or Selected WinCom Database Traces. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-24: Exporting Selected Records or Traces to POP Format 
 

Note:             If there are any records  that need additional formatting information, WinCom provides a 
window  to edit  the identification for  the traces.  Choose  Headend  Trace or Test Point 
Trace and edit the information. Click OK to continue. 

 

 
 

Figure 4-25: Editing dialog 
 

5. Import or edit the system information. 
 

WinCom prompts you to import information for your cable system that appears in the 
report header. If you have exported this information into an ASCII format (see section 4.6 
starting on page 4-19) as part of a records database, you can import the SystemInfo.csv file 
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now. Click Yes and browse to the directory where your system information is located. The 
file must have the extension .CSV. If you do not have a system information file, you can 
enter the information for the VeEX report header now. 

 

Follow the prompts on screen: 
•    company name 
•    system name 
•    street address (street and municipality) 
•    state (or province) 
•    ZIP code (or postal code) 
•    number of subscribers 
•    number of integrated hubs 
•    system bandwidth 
•    year of the last triennial test 
•    test channels (1 to 13) 

 
6. WinCom prompts you for a channel plan. 

•    To use the channel plan that was exported with the records, click Yes. 
• To select a different channel plan for your own exported channel plan files, click No 

and browse to the directory where your channel plan is located. The file must have the 
extension .CSV. If you have not yet exported a channel plan, see section 4.6.3 on 
page 4-20. Select the channel plan and click OK to continue. 

 
 

Important:  For purposes of data integrity, the channel  plan should  be finalized  and 
used throughout the testing cycle. 

 
 

WinCom opens the VeEX preformatted Excel file and populates the appropriate cells, using 
the data for your system and the data in the records you selected. Consult each tab in the Excel 
file to view the summary, headend and test point data. 



 

 



 

 

 
 
 

Chapter 5 CHANNEL PLAN EDITOR 

5-1 

 
The channel plan editor (applicable only to AT2500 channel plans) lets you make changes to 
an existing plan, or create a new plan either by starting fresh or by copying an existing plan. 
Use the channel plan editor to define each channel in the plan, such as its position, type, 
frequency and a selection of VITS parameters to indicate where particular test signals are for 
most of the CATV tests available. 

 

In addition to standard TV or digital channels, the channel line-up can also include leakage 
detector pilot signals or data carriers. 

 
 

Important:    For AT2500 series  used in conjunction with  ReVeal WinCOM s/w version  
2.2, alterations can  be  made  to  the  channel  plans  while  making 
measurements in the field. S/W version  2.2 provides the ability  to import 
edited  channel  plans  via the Channel  Plan Editor,  therefore  eliminating 
the need to replicate them exactly on the PC. 

 

Prior to WinComII s/w version 2.2, no alterations to the channel plans can 
be made while  making  measurements in the field.  If any changes  are 
made in the field, the data will not be exported  properly to FCC reports 
such as the VeEX report or Family Ware POP program. If changes were 
made in the field,  replicate  them exactly  on the PC that will  receive  the 
field traces and produce  the FCC report. See section  5.4 on page 5-10 for 
instructions on editing a channel plan in WinComII. 

 
 

In either case, for purposes of data integrity, the channel plan should  be 
finalized and used throughout the testing cycle. 

 
 

5.1 Creating a Channel Plan File 
 

A channel plan file can contain several channel plans. Each plan contains a specific channel 
line-up that you define. ReVeal WinCOM includes a few sample channel plans (.SCP 
files) that contain typical channel parameters based on the television standards in various 
geographical regions. You may want to consult one of the sample channel line-ups before 
creating your own. 

 

To create a new channel plan: 
 

1. From the  ReVeal WinCOM  Tools  menu,  select  Launch  Channel Plan  Editor.  By  
default, ReVeal WinCOM opens either the last channel plan file that was opened, or, if 
this is the first time you are using the Channel Plan Editor, it opens a blank channel plan 
file window. 
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Figure 5-1: Creating a New Channel Plan 
 

The top part of the Channel Plan Editor window shows the information for each channel in 
the plan. The bottom part provides fields to name your channel plan and add notes. 

 

2. Enter the Plan Description information. 
• Select a name for your new channel plan. The name cannot have any spaces. If you 

want to separate words, use a character such as the underscore “_”. 
•    If desired, edit the description. Spaces are accepted in the description field. 
• If desired, enter your name in the Author field, without any spaces. If you want to 

enter your first and last name, separate each word with an underscore “_”. 
 

3. To save the basic setup for the channel plan file, go to the File menu and select Save As. 
Browse to the directory you want to use. By default, the Channel Plan directory is selected. 
Choose a name. ReVeal WinCOM adds the file extension .SCP. 

 

4. To continue adding channel plans to this file, click New Plan and repeat step 2. The new 
plan’s tab appears when you click New Plan or when you select another channel plan. 

 
You are now ready to add channels to a channel plan. See section 5.2.1 for analog channels, 
section 5.2.2 for digital channels, or section 5.2.3 for other channels. 

 
 

5.2 Defining  Channels 
 

5.2.1 Defining  an Analog Channel 
 

To define a channel, you must first open a channel plan file in the Channel Plan Editor. See 
section 5.1 to open the Channel Plan Editor. 

 

1. Open a channel plan file. 
When you launch the Channel Plan Editor, ReVeal WinCOM opens the last channel plan 
file that was used. If this is not the channel plan file that you want to use, use the File menu 
to open another file with the extension .SCP. If this is the first time you are using the 
channel plan editor, a blank channel plan window appears. 
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2. Select the channel plan that will contain the new channel. 

A typical channel plan file contains several channel plans. The name of each plan in the 
file appears on a tab at the top of the window. If you are using a blank channel plan file, 
there are no tabs. Once you enter the channel plan file description (see section 5.1), you 
will see a tab at the top of the window. To add channels to one of the channel plans, first 
select the channel plan by clicking on a tab. 

 

3. To add a channel to a channel plan, click New Channel. This opens the window used to 
define each channel. You need to use the tab menus to access all of the fields you need to 
complete for each channel. Go to the Channel Information tab and enter the information 
for the first channel in this channel plan. 

 

 
 

Figure 5-2: Setting up an Analog Channel 
 

• Enter the channel number in the Channel field. You can use up to 4 alphanumeric 
characters. 

•    Enter a name, using up to 20 alphanumeric characters. 
• Select the channel type: Analog, Digital, or Other. Once you select the type (analog, 

digital or other) the tab menus vary in order to present only the relevant fields you 
need. This section covers the instructions for analog channels. 

• Select the Autotest Scan checkbox to include the channel in the automatic tests that 
the spectrum analyzer performs. 

•    Select Forward for downstream or forward path transmission channels, or select 
Reverse for upstream or return path signals. 

 
4. Enter the analog channel’s frequency information if you selected Analog in step 3. If you 

selected Digital, skip to section 5.2.2 on page 5-5. If you selected Other, skip to section 
5.2.3 on page 5-6. Use these fields to define the channel’s visual carrier frequency and 
scrambling, and the offset of the channel’s aural carriers. You can also define FM and 
digital audio channels in this window.                                                                             

 

Field                                  Data Range                                             Default Value 
 

Frequency 5 to 1500 MHz 55.25 
Modulation NTSC-M, PAL-B, PAL-G/H, PAL-I, 

PAL-M, PAL-N, SECAM-B, SECAM- 
NTSC-M 
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Field Data Range Default Value 

 G/H, SECAM-K/L, Unknown  
Audio Freq 4 to 8 MHz 4.5 
Audio 2 Type None, FM, Digital None 
Audio 2 Freq* 4 to 8 MHz 0 
Audio 2 BW* 0 to 2 MHz 0 
Channel Width Low -2 to -1 MHz -1.25 

High 4 to 6.75 MHz 4.75 
Scrambling None, Horizontal, Vertical None 

 
* These fields can only be edited if you selected FM or Digital in the Audio 2 Type field. 

 
5. Enter  the  analog  channel’s  distortion  information.  Use  this  window  to  define  the 

composite triple beat (CTB), carrier to composite noise (CCN) and composite second 
order (CSO) distortion parameters.                                                                                  

 

Field Data Range Default value 
 

Video Noise BW 
 

4 to 6 MHz 
 

4 
CTB Gated Line 7 to 35 15 
CTB Gated Field Field 1, Field 2, Both Field 1 
CTB Freq. Offset -9.99 to 9.99 MHz 0 
CSO Gated Line 7 to 35 15 
CSO Gate Field Field 1, Field 2, Both Field 1 
Freq. Offset Low 1* -9.99 to 0 MHz -1.25 
Freq. Offset High 1* 0 to 9.99 MHz 0.75 
Freq. Offset High 2* 0 to 9.99 MHz 1.25 
Freq. Offset Low 2* -9.99 to 0 MHz -0.75 
CCN Gated Line 7 to 35 15 
CCN Gated Field Field 1, Field 2, Both Field 1 
CCN Freq. Offset Low -9.99 to 9.99 MHz 2 

High -9.99 to 9.99 MHz 2 
 

* Select the checkbox to tag the frequency. 
 

6. Enter the analog channel’s miscellaneous information. Use this window to define the 
channel’s in-channel frequency response and depth of modulation parameters.   

 

Field Data Range Default value 
 

IRC Line 
 

7 to 35 
 

19 
IRC Field Field 1, Field 2 Field 1 
IRC Signal Type Multiburst, GCR, Cable Sweep Multiburst 
IRC Freq. 1 .5 to 5 MHz 0.5 
IRC Freq. 2 .5 to 5 MHz 1.25 
IRC Freq. 3 .5 to 5 MHz 2.0 
IRC Freq. 4 .5 to 5 MHz 3.0 
IRC Freq. 5 .5 to 5 MHz 3.6 
Hum Video, CW Video 
Hum Freq 50, 60 Hz 60 
DOM Line 7 to 35 17 
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Field 
 

Data Range 
 

Default value 

DOM Field 
DOM Signal Type 

Field 1, Field 2 
Multiburst, NTC-7, Composite TX 

Field 1 
Multiburst 

 

7. Enter the analog channel’s video test information. Use this window to define the channel’s 
luminance and chrominance parameters as well as signal to noise.   

 

Field  Data Range  Default value 
 

Video Diff Gain/Phase 
Line 7 to 35 17 
Field Field 1, Field 2 Field 1 

 
 
 

Video YC 

Signal Type NTC-7, Composite TX, Full line 5 
steps, Full line 10 steps, Full line ramp 

NTC-7 

Line 7 to 35 17 
Field Field 1, Field 2 Field 1 

 
 
 

Video SN 

Signal Type NTC-7, Composite TX, Sine-squared 
pulse & bar 

NTC-7 

Line 7 to 35 17 
Field Field 1, Field 2 Field 1 

Signal Type NTC-7, Composite TX, Sine-squared 
pulse & bar 

NTC-7 

 
8.    Click Apply to record your changes and then continue adding more channels to this plan. 

Remember to save the channel plan file from time to time when you are editing the file. 
 
 
 
 
 

5.2.2 Defining  a Digital Channel 
 

To define a digital channel, you must first open a channel plan file in the Channel Plan Editor 
(see section 5.1). Once you have opened the Channel Plan Editor, choose a channel plan file, 
and then select the channel plan within the file where you want to add the new digital channel. 
See steps 1 and 2 in section 5.2.1 to open a channel plan. 

 

To add a digital channel to a channel plan: 
 

1.    Click New Channel or select New Channel from the Edit menu. Go to the Channel 
Information tab and enter the information for the first channel in this channel plan 
• Enter the channel number in the Channel field. You can use up to 4 alphanumeric 

characters. 
• Enter a name, using up to 20 alphanumeric characters. 
• Select the channel type: Analog, Digital, or Other. Once you select the type (analog, 

digital or other) the tab menus vary in order to present only the relevant fields you 
need. This section covers the instructions for digital channels. 

• Select the Autotest Scan checkbox to include the channel in the automatic tests that 
the spectrum analyzer performs. 

• Select Forward for downstream or forward path transmission channels, or select 
Reverse for upstream or return path signals. 
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2. Enter the digital channel’s frequency and modulation information if you selected Digital in 

step 1. If you selected Analog, see section 5.2.1 on page 5-2. If you selected Other, skip to 
section 5.2.3. Use these fields to define the digital channel’s polarity and bandwidth. 

 

 
Figure 5-3: Setting up a Digital Channel 

 
 

 

Field 
 

Data Range 
 

Default value 
 

Center Frequency 
 

5 to 1500 MHz 
 

555 
Order QAM64, QAM256 QAM256 
Symbol Rate 5 - 7 MS/s 5360537 
Polarity Normal, Reverse, Automatic Normal 
Channel width 1 to 10 MHz 6 
J83 Annex None, A, B, C B 

 

3.    Click Apply to record your changes and then continue adding more channels to this plan. 
Remember to save the channel plan file from time to time when you are editing the file. 

 
 
 

5.2.3 Defining  Other Channels 
 

“Other” channels can be leakage detection pilot carriers or other carriers such as QAM16 
upstream signals used for monitoring. They are not standard analog or digital channels. 

 

To add a special carrier to the channel plan, you must first open a channel plan file in the 
Channel Plan Editor (see section 5.1). Once you have opened the Channel Plan Editor, choose a 
channel plan file, and then select the channel plan within the file where you want to add the 
new channel. See steps 1 and 2 in section 5.2.1 to open a channel plan. 

 

1. To add one channel, click New channel or select New channel from the Edit menu. Go to 
the Channel Information tab and enter the information for the first channel in this channel 
plan 
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• Enter the channel number in the Channel field. You can use up to 4 alphanumeric 

 

characters. 
• Enter a name, using up to 20 alphanumeric characters. 
• Select the channel type: Analog, Digital, or Other. Once you select the type (analog, 

digital or other) the tab menus vary in order to present only the relevant fields you 
need. This section covers the instructions for Other channels. 

• Select the Autotest Scan checkbox to include the channel in the automatic tests that 
the spectrum analyzer performs. 

• Select Forward for downstream or forward path transmission channels, or select 
Reverse for upstream or return path signals. 

 
2. Enter the channel’s center frequency and modulation if you selected Other in step 1. If you 

selected Analog, see section 5.2.1 on page 5-2. If you selected Digital, see section 5.2.2 on 
page 5-5. Use these fields to define the modulation and bandwidth. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-4: Setting up Other Channels 
 

Field  Data Range  Default value 
 

Center Frequency 5 to 1500 MHz 88.1 
Channel Width 0.1 to 10 MHz 0.2 
Type QPSK, QAM16, QAM32, FSK, BPSK, FM 

CW, VSB-AM, FM, CDMA 
Symbol Rate* 0 to 99999999 S/s 0 
Burst Burst, Continuous Continuous 

 
TDMA Length 0 to 999999 ms 0 
Repeat 0 to 999999 ms 0 

 
* Not used for FM and CW carriers. 

 

3. Click Apply to record your changes and then continue adding more channels to this plan. 
Remember to save the channel plan file from time to time when you are editing the file. 
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5.2.4 Defining  Multiple  Channels 

 
ReVeal WinCOM’s Create Multiple Channels command lets you add a group of similar 
channels to a channel plan all at once. Use this method to save time setting up a channel plan. 

 

To define a multiple channels, you must first open a channel plan file in the Channel Plan 
Editor (see section 5.1). Once you have opened the Channel Plan Editor, choose a channel plan 
file, and then select the channel plan within the file where you want to add the new channels. 
See steps 1 and 2 in section 5.2.1 to open a channel plan. 

 

To create multiple channels: 
 

1. From the Channel Plan Editor, select Create Multiple Channels from the Edit menu. By 
default, ReVeal WinCOM opens a single channel range, starting at 55.25 MHz. 

 

 
Figure 5-5: Creating Multiple Channels 

 

2. In the Channel Range section, decide how many channels you want to add. Enter the 
starting and ending channel numbers in the From and To fields. 

 

3. In the Frequency Range section, enter the starting frequency for the first channel and the 
number of megahertz between each channel. ReVeal WinCOM calculates the frequencies 
automatically for all of the channels in the range. 

 

4. In the Channel section, define the basic parameters that are common to all of the channels 
you are adding: 
• Select the channel type from the available choices: Analog, Digital, or Other. 
• Select the modulation type from the available choices: NTSC-M, PAL-B, PAL-G/H, 

PAL-I, PAL-M, PAL-N, SECAM-B, SECAM-G/H, SECAM-K/L. 
 

Note:             In a new channel  plan, all of the channels  use WinCom  II’s default  values  for analog, 
digital  or other  channels.  Refer to section  5.1 for  details  on the parameters  for  each 
channel type. 

 

5. Click OK to create the new channels. You can now select each channel in the list at the top 
of the window, and edit any specific parameters. For editing analog channel parameters, 
see section 5.2.1 on page 5-2. For digital channels, see section 5.2.2 on page 5-5. For 
“other” channels, see section 5.2.3 on page 5-6. 
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6. To create another series of channels in the same channel plan, select Create Multiple 

 

Channels again from the Edit menu. You can now apply the channel parameters of the first 
series of channels you defined, in steps 4 and 5, to the new series of channels are creating. 
To do so, select the checkbox “Use values from channel x instead of defaults”, where x is 
the highest channel you defined. To keep the defaults for the selected channel type, leave 
this checkbox unselected. 

 
5.3 Copying  a Channel Plan 

 

ReVeal WinCOM’s Copy Plan command creates a new channel plan using an existing plan. 
This is an easy way to copy channel settings that are common to multiple locations. You can 
then add or delete certain channels to customize your new plan. 

 

ReVeal WinCOM comes with several sample channel plan files. You may want to choose a 
sample file that is closest to your current plan, and then use the Copy Plan method to save time 
setting up a channel plan. 

 

To copy a plan: 
 

1.    First open a channel plan file in the Channel Plan Editor (see section 5.1). 
 

2. Once you have opened the Channel Plan Editor, choose a channel plan file, and then select 
the channel plan within the file that you want to copy. Use the tabs at the top of the 
window to select a channel plan. 

 

3.    Click Copy Plan to create a new plan. The new plan’s tab appears. 
 

4.    Edit the plan description: 
• You can change the name of the plan in the Plan Name field in the bottom part of the 

window. By default, ReVeal WinCOM adds the number “1” to the name of the new 
plan to indicate that it is a copy. Select a new name for your channel plan. The name 
cannot have any spaces. If you want to separate words, use a character such as the 
underscore or dash. 

•    If desired, edit the description. Spaces are accepted in the description field. 
• If desired, enter your name in the Author field, without any spaces. If you want to 

enter your first and last name, separate each word with an underscore or dash. 
 

You can now edit the channel plan or some of the channels in the plan. To add or delete 
channels, see section 5.4. For details on changing channel parameters, refer to section 5.2.1 for 
analog channels, section 5.2.2 for digital channels, or section 5.2.3 for other channels. 
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5.4 Editing  a Channel Plan 
 

If you have copied a channel plan to use as a starting point, you may want to make changes for 
a particular location. You can add or delete channels as required, or edit the settings for a 
particular channel. 

 
 

Important:    For AT2500 series used in conjunction with ReVeal WinCOM s/w version  
2.2, alterations can  be made  to  the  channel  plans  while  making 
measurements in the field. S/W version 2.2 provides the ability to import 
edited channel  plans via the Channel Plan Editor,  therefore  eliminating 
the need to replicate them exactly on the PC. 

 
Prior to WinComII s/w version  2.2, no alterations to the channel  plans 
can be made while  making  measurements in the field.  If any changes 
have been made in the field,  the data will  not be exported  properly to 
FCC reports  such as the VeEX  report  or Family Ware POP program. 
Make sure you replicate  the changes exactly on the PC that will receive 
the field traces and produce the FCC report. 

 
 

In either case, for purposes of data integrity, the channel plan should be 
finalized and used throughout the testing cycle. 

 
 

To edit a plan: 
 

1. First open a channel plan file in the Channel Plan Editor (see section 5.1). 
 

2. Once you have opened the Channel Plan Editor, choose a channel plan file, and then select 
the channel plan within the file that you want to edit. Use the tabs at the top of the window 
to select a channel plan. 

 

3. You can now make changes to the channel plan or to a specific channel.   
Action  Commands  and Reference to Instructions 

 
Copying a plan Click Copy Plan (see section 5.3 on page 5-9). 
Creating a plan Click New Plan (see section 5.1 on page 5-1). 
Deleting a plan Click Delete Plan to remove the selected plan from the file. 
Creating a channel Click New Channel to add a channel to the selected plan (see 

section 5.2 on page 5-2) 
Deleting a channel Click Delete Channel to remove the channel plan from the plan. 
Editing a channel Select a channel and use the tabs to access the channel parameter 

menus. The tabs vary according the channel type. See section 
5.2.1 for analog channels, section 5.2.2 for digital channels, or 
section 5.2.3 for other channels, 
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5.5 Saving, Importing, & Exporting a Channel Plan 
 

ReVeal WinCOM can import and export the channel plans you create or edit into a format that 
can be uploaded to a spectrum analyzer. Channel plan files which have the .SCP file 
extension are editable. Channel plan files with the .SCP file extension are exported to a file of 
type .ACP. Channel plan files with the .ACP extension are required in order to transfer the 
channel plan to a spectrum analyzer. The Channel Plan Editor utility within ReVeal WinCOM 
provides the ability to export and convert .SCP files to .ACP files. 

 
 

5.5.1 Saving a Channel Plan File 
 

To save a channel plan file in a format that can be edited by ReVeal 
WinCOM: 

 

1. Choose Save or Save As from the Channel Plan Editor’s File menu. Save overwrites the 
channel plan file with your changes, and keeps the same name. Save As opens a dialog 
box so you can choose another name and directory. 

 

2.    Browse to the directory you want to use. By default, the Channel Plan directory is selected. 
 

3.    Choose a name for your channel plan file. ReVeal WinCOM adds the file extension 
.SCP 

automatically. 
 

4.    Click OK to record your changes in the channel plan file. 
 

Note              When you exit a channel plan file or when you open a new file, ReVeal WinCOM prompts 
you to save your changes.  This is a normal  save operation and does not allow you to 
change the name or location of the file. 

 
 
 

5.5.2 Importing a Channel Plan File 
 

To import channel plan files from the AT2500 spectrum analyzer (files with .ACP extension) 
into the Channel Plan Editor format (files with .SCP extension): 

 

1.    Choose the Channel Plans entry in the Remote Files. 
 

2.    Select the specific file which contains the channel plan to be imported. 
 

3. Move the file over to the local files into a desired directory where the channel plan is to 
reside. 

 

4.    Launch the Channel Plan Editor. 
 

5. Choose Import from the Channel Plan Editor’s File menu. This opens the Import dialog 
box. 

 

6.    Browse to the directory which contains the channel plan and open the file. 
 

7.    Proceed to make changes for each channel as required to the imported channel plan file. 
 

8.    Refer to Section 5.5.1 to save the file. 
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5.5.3 Exporting a Channel Plan File 
 

Important:    For AT2500 series  used in conjunction with  WinCom  II s/w version  2.2, 
alterations can  be  made  to  the  channel  plans  while  making 
measurements in  the  field.  Version  2.2 provides the  ability  to  import 
edited  channel  plans  via the Channel  Plan Editor,  therefore  eliminating 
the need to replicate them exactly on the PC. 

 
 

Prior to WinComII s/w version  2.2, no alterations to the channel plans can 
be made while  making  measurements in the field.  If any changes  are 
made in the field, the data will  not be exported  properly to FCC reports 
such as the VeEX report or Family Ware POP program. If changes were 
made in the field,  replicate  them exactly  on the PC that will  receive  the 
field traces and produce the FCC report. 

 
 

In either case, for purposes of data integrity, the channel plan should  be 
finalized and used throughout the testing cycle. 

 
 

To export a channel plan file in a format that can be transferred to an AT2500 series spectrum 
analyzer: 

 

1. Choose Export from the Channel Plan Editor’s File menu. This opens the Export dialog 
box. 

 

2. Browse to the directory you want to use. By default, the Channel Plan directory is selected. 
 

3. Choose a name for your channel plan file. ReVeal WinCOM adds the file extension 
.ACP 

automatically. 
 

4. Click Save to export the channel plan file to a format for the AT2500 series spectrum 
analyzer. 

 

5. Move the file over from the local files to the remote files. 
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Chapter 6 TROUBLESHOOTING AND 
MAINTENANCE 

 
This chapter includes procedures for using ReVeal WinCOM on another computer, 
uninstalling ReVeal WinCOM, and for upgrading the spectrum analyzer. VeEX’s 
technical support contact information is included at the end of this chapter. 

 
6.1 Moving to a New Computer 

 

ReVeal WinCOM only works on the computer that you used to install and register the 
software. If you need to install ReVeal WinCOM on a different computer, you need to obtain 
a new password for that computer. 

 

When moving ReVeal WinCOM to another computer you must, as stated in the License 
Agreement, remove WinCom or ReVeal WinCOM from the old computer. 

 

Follow the instructions for program removal in section 6.2, then install and register ReVeal 
WinCOM 
on another computer. See Chapter 2 for installation and registration instructions. 

 
6.2 Uninstalling ReVeal WinCOM 

 

ReVeal WinCOM must be removed from your computer if you want to install it on a 
different computer, in accordance with the License Agreement. 

 

ReVeal WinCOM is removed from your computer the same way that any other program is 
removed using the Windows operating system. Some steps in the program removal procedure 
may be slightly different depending on your operating system. 

 

To remove ReVeal 
WinCOM: 

 

1.    Go to the Windows Control Panel. You can access the Control Panel through the 
Windows Start menu. For Windows 2000, select Settings then Control Panel. 
• In the Control Panel, select Add/Remove Programs. 
• Select ReVeal WinCOM  from the  displayed  list and  click  Add/Remove or 

Remove, depending on your operating system. Follow the onscreen prompts. 
 

Note:  Data files are never deleted, only program files. 
 
 
 
 

6.3 Upgrading Firmware 
 

ReVeal WinCOM includes a simple utility for upgrading the spectrum analyzer’s firmware 
with a special firmware file from VeEX: 

 

AT2000 “L” type analyzers  file extension .ULF 
AT2000 “D” type analyzers  file extension .UDF 
AT2500 with parallel port file extension .TAR.GZ 
AT2500 with USB port file extension .RUN 

 
 

Note:             All  user  parameters   are  set  to  their  factory   default  values  when  you  upgrade  the 
firmware.  Your channel plan is still  in memory, but it may not be selected  as the default 
plan. All stored  measurements and settings are also kept in memory.  As a precaution, 
download the stored data from the spectrum analyzer every time you upgrade or update 
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the firmware  to avoid the possibility of losing  data due to the incompatibility of a given 
parameter. See section 4.6, Exporting Data on page 4-19 for more information. 

 

For firmware upgrades, the spectrum analyzer must be in remote mode. On the “R” series, 
from any mode except Menu, press the COMM function button to put the unit into remote 
mode. Or, select the Remote icon in the menu, and then select a mode such as Spectrum 
Analyzer. On “HM” models, the unit is normally set to operate in remote mode by default. 
To upgrade the spectrum analyzer’s firmware: 

 

1. Make sure you have the appropriate firmware. VeEX provides update files on disk, or 
they can be downloaded from the website at www.VeEXtelecom.com. You must have a 
password in order to download files from the web site. Contact VeEX’s customer support 
department to obtain a password. 
•    Make sure the spectrum analyzer is in remote mode. 
• Run  the  WinCom  II  software  and  establish  communication  with  the  spectrum 

analyzer. 
• Select Upgrade Firmware from the ReVeal WinCOM Communications menu. 

Using the dialog box, select the firmware file. The firmware file has the extension 
“.TAR.GZ” for an AT2500 with a parallel port or “.RUN” for an AT2500 with USB 
ports. 

•    Double-click on the file to start the upgrade procedure. 
• Once the file transfer is complete, ReVeal WinCOM will attempt to reconnect 

to the AT2500. It may take several minutes for the new firmware to load in the 
AT2500, in which case the reconnect attempt will time out. 

•    Remember to set up your user parameters in the spectrum analyzer. 
 
 
 

6.4 Troubleshooting Communication Errors 
 

If you are having problems following a Windows session crash while you were connected to 
the analyzer, please note that it may take up to 3 minutes before Windows closes the socket and 
before the analyzer allows another log on attempt. 

 

If you still cannot connect after 3 minutes, check the following. 
 

1. Check for cabling errors. The spectrum analyzer needs to be connected to the PC or to the 
same network as the PC. Note that for direct connections, a crossover cable (Ethernet) or 
null modem cable (serial) is required. For connection information, see Chapter 2. 

 

2. Check the firmware version of the spectrum analyzer. In order to operate with ReVeal 
WinCOM, you need firmware version 4.21 or higher for the AT2000, and you need 
firmware 1.00 or higher for the AT2500. 
•    Check the analyzer’s remote setup: 
•    server mode active (system type is set to “Server”) 
•    system ID matches the ID in ReVeal WinCOM’s 
connection 
•    TCP/IP network is initialized 
•    analyzer is in remote mode 

 
On the “R” series, from any mode except Menu, press the COMM function button to put 
the unit into remote mode. On “HM” models, the unit is normally set to operate in remote 
mode by default. 
•    Check the port setup used for remote communication on the analyzer and on the PC. 

Make sure that you have configured the communications in ReVeal WinCOM to 
match the communication settings in the analyzer: 

•    For serial communications, make sure the port speed matches. 
• For TCP/IP connections, make sure you have the correct subnet mask and gateway, if 

applicable. Check the IP address of the analyzer. 

http://www.sunrisetelecom.com/
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Technical Support  

 
VeEX Inc. is committed to excellent service worldwide. Our goal is to provide you with 
professional assistance in the use of our software and services, wherever you are located. 
Technical Support and Customer Service solutions may vary by country. VeEX also provides 
product training to regional VeEX representatives so that they can offer some product support 
in your region in a prompt and personalized manner. 
 

Customer Care 
Tel: + 1 510 651 0500 
Fax: +1 510 651 0505 

E-mail: customercare@veexinc.com 
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Chapter 7 LEGAL NOTICES 
 

 
 
 

License Agreement 
Software License Agreement 
 

WARNING: VEEX, INC. IS WILLING TO LICENSE THE ENCLOSED Reveal WinCOM SOFTWARE 
(HEREINAFTER THE "SOFTWARE") AND USER DOCUMENTATION TO YOU ONLY UPON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS LICENSE 
AGEEEMENT. PLEASE READ THE TERMS CAREFULLY BEFORE OPENING THIS PACKAGE 
OR CLICKING ON THE "YES" BUTTON, AS DOING SO WILL INDICATE YOU’RE ASSENT TO 
THEM. IF YOU DO NOT AGREE TO THESE TERMS, THEN VEEX, INC. IS UNWILLING TO 
LICENSE THE SOFTWARE TO YOU, IN WHICH EVENT YOU SHOULD RETURN THE 
UNOPENED PACKAGE AND USER DOCUMENTATION TO THE PLACE FROM WHICH IT WAS 
ACQUIRED WITHIN THIRTY DAYS, AND YOUR MONEY WILL BE REFUNDED. 
 

LICENSE. In consideration of your payment of the license fee, VEEX, Inc. grants to you a nontransferable 
and non-exclusive license to use the Software on a single AT2500 spectrum analyzer. 

OWNERSHIP. You own the physical diskette(s) containing the Software and user documentation. VeEX 
retains title to the Software. This agreement does not transfer title or ownership of the Software or any 
underlying proprietary rights, patents, copyrights, trademarks, or trade secrets. You may transfer all your 
license rights in the Software, the backup copy of the Software and a copy of this License to another party, 
provided the other party reads and agrees to accept the terms and conditions of this License. 

SCOPE OF GRANT. You may: 

* use the Software on any single computer; 

* use the Software on a network, provided that each person accessing the Software through the network 
must have a copy licensed to that person;  

* copy the Software for backup purposes, provided any copy must contain all of the original Software's 
proprietary notices. 

RESTRICTIONS. You may not: 

* permit other individuals to use the Software except under the terms listed above; 

* permit concurrent use of the Software; 

* modify, translate, reverse engineer, decompile, disassemble (except to the extent applicable laws 
specifically prohibit such restriction), or create derivative works based on the Software; 

* copy the Software other than as specified above; 

* rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or 

* remove any proprietary notices or labels on the Software. 
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TERM. The license granted that under this agreement is effective until terminated. You may terminate it at 
any time by destroying the Software together with all copies, modifications and merged portions in any 
form. This license will terminate immediately without notice from VEEX, Inc. if you fail to comply with 
any provisions of this License. You agree upon such termination to destroy the Software, together with all 
copies, modifications and merged portions in any form, and to certify to VEEX, Inc. that they have been 
destroyed. Upon termination there will be no refund of any monies or consideration paid by you.  

EXPORT LAW ASSURANCES. You agree and certify that neither the Software nor any other technical 
data received from VEEX, Inc., nor the direct product thereof, will be shipped, transferred, or exported, 
directly or indirectly, outside the country within which the Software was purchased without the express 
written consent of VEEX, Inc. 

NO WARRANTIES. VeEX expressly disclaims any warranty for the software product. The software 
product and any related documentation is provided "AS IS" without warranty of any kind, either express or 
implied, including, without limitation, the implied warranties of merchantability, fitness for a particular 
purpose, or non-infringement. The entire risk arising out of use or performance of the software product 
remains with you. 

LIMITATION OF LIABILITY. To the maximum extent permitted by applicable law, in no event shall 
VeEX or its suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever 
(including without limitation, damages for loss of business profits, business interruption, loss of business 
information, or any other pecuniary loss) arising out of the use of or inability to use the software product 
or the provision of or failure to provide support services, even if VeEX has been advised of the possibility 
of such damages. In any case, VeEX Telecom's entire liability under any provision of this Agreement shall 
be limited to the greater of the amount actually paid by you for the software product or US$5.00; provided 
however, if you have entered into a VeEX Support Services Agreement, VeEX Telecom's entire liability 
regarding Support Services shall be governed by the terms of that agreement. Because some states and 
jurisdictions do not allow the exclusion or limitation of liability, the above limitation may not apply to 
you. 

HIGH RISK ACTIVITIES. The Software is not fault-tolerant and is not designed, manufactured or 
intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe 
performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, 
air traffic control, direct life support machines, or weapons systems, in which the failure of the Software 
could lead directly to death, personal injury, or severe physical or environmental damage ("High Risk 
Activities"). Licensor and its suppliers specifically disclaim any express or implied warranty of fitness for 
High Risk Activities. 

US GOVERNMENT END USERS. This Agreement is not valid and shall not come into effect for any 
unit or agency of the United States government until the execution and delivery by both you and VEEX, 
Inc. of a RESTRICTED RIGHTS Government User Supplement in the form required by VEEX, Inc. 

MISCELLANEOUS. If the copy of the Software you received was accompanied by a printed or other 
form of "hard-copy" End User License Agreement whose terms vary from this Agreement, then the hard-
copy End User License Agreement governs your use of the Software. This Agreement represents the 
complete agreement concerning this license and may be amended only by a writing executed by both 
parties. THE ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY YOU IS EXPRESSLY 
MADE CONDITIONAL ON YOUR ASSENT TO THE TERMS SET FORTH HEREIN, AND NOT 
THOSE IN YOUR PURCHASE ORDER. If any provision of this Agreement is held to be unenforceable, 
such provision shall be reformed only to the extent necessary to make it enforceable. This Agreement shall 
be governed by California law (except for conflict of law provisions). The application the United Nations 
Convention of Contracts for the International Sale of Goods is expressly excluded.  
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COMPLETE AGREEMENT. This License constitutes the entire agreement between the parties with 
respect to the use of the Software and related documentation, and supersedes all prior or contemporaneous 
understandings or agreements, written or oral, regarding such subject matter. No amendment to or 
modification of this License will be binding unless in writing and signed by a duly authorized 
representative of VEEX, Inc.  
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